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Every substance is made up of atoms.
Atom consists of protons, neutrons, electrons.
❖ Protons  = Positive charge
❖ Electron = Negative charge
❖ Neutron = Zero charge

Mass Charge

Proton 1.673 X 10-27 kg + 1.6 X 10-19 C

Electron 9.1 X 10-31 kg - 1.6 X 10-19 C

Neutron 1.675 X 10-27 kg 0

✓ Charge: Scalar quantity
✓ Units: Coulomb (C)
✓ Dimensional formula: [AT]

Electric charge



Unlike charges attract

How  do charges behave?

- -

+

+

Like charges repel

+

-



The force of attraction or repulsion between two 
electric point charges is directly proportional to 
the product of the magnitude of  charges and 
inversely proportional to the square of the 
distance between the two charges.

F = 
𝒌 𝒒𝟏𝒒𝟐

𝒓𝟐

k =
1

4𝜋𝜀0
 = 9X109 Nm2/C2 

ε0 = 8.85x10-12 C2 /Nm2

Coulomb’s law

Units: Newton (N)
It is a Vector quantity



The region surrounding an 

electric charge or a group of 

charges, in which another charge 

experiences a force is called 

electric field.

Electric Field

Electric field intensity E = 
F

q

Units: N/C, V/m, Vector quantity



Intensity of electric field due to a point charge

E = 
F

𝑞0
 

F = 
𝑘 𝑞𝑞0

𝑟2

E = 
𝟏

𝟒𝝅𝜺𝟎
(

𝒒

𝒓𝟐)

+q +𝑞0
r

F

EP



Limitations of Coulomb’s Law 

Gauss’s law

❑  Coulomb’s law is valid for point charges only. 

❑  It is valid only for static charges. 

❑  It is valid only up to nuclear distance of 10-15 m.

❑  It is complex to deal with charges having irregular shapes.

❑  It is difficult to apply Coulomb’s law when the charges are 

     in arbitrary shape. 



Electric flux

The electric flux through a surface placed inside electric 
field represents the total number of electric field lines 
crossing the surface in a direction normal to the 
surface.

∅𝐸 = ර 𝑬 ∙ ∆𝑺

∅𝐸  =  E S cos 𝜃

Units: N.m2 /C, Scalar quantity



Electric flux depending factors

•  Electric flux is proportional to 
the density of flow (E).

•  Electric flux varies by how the      
boundary faces the direction of 
flow (𝜃).

•  Electric flux is proportional to 
the area within the boundary (S).

∅𝑬 =  E . S= E S cos 𝜃

(A)

(C)

(E)

(B)

(D)

(F)



(c)  = EA cos 𝜃(a)  = EA (b)  = 0

Calculate the flux of the electric field E, through 

the surface A, in each of three cases shown.



❖  Flux is positive for field lines that leave enclosed    
      volume
❖  Flux is negative for field lines that enter enclosed    
      volume

▪ If a charge is outside a 
closed surface, the net flux is 
zero.

▪ Lines leaving the surface is 
same as lines entering.

Properties of Electric flux



2q charge is out of closed surfaces c, d.
Net electric flux is zero for surfaces c and d. 

For which of these closed surfaces (a, b, c, d) the flux of the 

electric field, produced by the charge +2q, is zero?



Gauss’s law  (History)

CARL FRIEDRICH GAUSS

German Scientist

• Gauss’s law is basically the 
relation between the distribution 
of charges to the resulting 
electric field.

• Gauss’s law is based on the fact 
that flux through any closed 
surface is measure of total 
amount of charge inside that 
surface.

• Any charge outside that surface 
would not contribute anything to 
the total flux.



Gauss Law states that total normal 
electric flux ∅E over a closed surface is 
(1/𝜀0 )times the total charge q enclosed 
within the surface.

∅E = ර 𝐄 ∙ d𝐒 =
qenclosed

ε0
 

Differential form of Gauss’s law 

q = ρ׮  dV , ρ = volume charge density, 

Gauss divergence theorem  

ׯ 𝐄 ∙ d𝐒 ׮ = div𝑬 dV  

Electric displacement vector D = ε0E 

𝛁. 𝐄 =
ρ

ε0
,  𝛁. 𝐃 = ρ 

Integral form of Gauss’s law 

*Maxwell’s First equation*

Gauss’s law

∅𝐄 =
𝐪𝐞𝐧𝐜𝐥𝐨𝐬𝐞𝐝

𝛆𝟎



Surface a, a =
+ 2q

ε0
 

Surface d, d = 
− q

ε0

Surface c, c = 0

Surface b, b =
+ q

ε0

Gauss’s law: ∅E =
qenclosed

ε0

Calculate the flux of the electric field 
for each of the closed surfaces a, b, c, and d



Linear charge density:  𝜆 =
𝑞

𝑙

Units: C/m

Surface charge density:  𝜎 =
𝑞

𝑆

Units: C/m2 

Volume charge density:  𝜌 =
𝑞

𝑉

Units: C/m3

Various Charge distributions

dq

Applications of Gauss’s law



Select a 
Gaussian 
surface with 
symmetry 
that matches 
charge 
distribution

Draw Gaussian 
surface so that 
electric field is 
either constant 
or zero at all 
points on the 
Gaussian 
surface

Use 
symmetry to 
determine 
direction of E 
on Gaussian 
surface

Evaluate 
surface 
integral  
(Electric 
flux)

Determine 
the charge 
inside the 
Gaussian 
surface

Solve for 
Electric 
field

Problem solving strategies for Gauss’s law



Cylinder SphereCube

Plane charge 
distribution: Infinite line 
of charge (Cylinder)

Surface charge 
distribution: Infinite sheet 
of charge (Cylinder)

Volume charge 
distribution: Charged 
Sphere (Sphere) 

How to select suitable closed Gaussian surface ?

Possible closed surfaces

Selection of suitable closed Gaussian surface



Linear charge distribution 𝜆 =
𝑞

𝑙

Gaussian surface:  coaxial 
cylinder of length l and radius r 

∅E = ׯ 𝐄 ∙ d𝐒 left endׯ =
𝐄 ∙ d𝐒+ ׯright end

𝐄 ∙ d𝐒+ ׯcurved surface
𝐄 ∙ d𝐒

∅E =  0+0 +ׯcurved surface
𝐄 ∙ d𝐒 = E. 2πrl ,      E. 2πrl =  

 λl

 ε0
 

Gauss’s law

∅E = ර 𝐄 ∙ d𝐒 =
qenclosed

ε0
 =

λl

ε0

Cylindrical  Gaussian surface

Right end

Curved surface

Left end

Graphical representation of 

electric field due to a infinity 

long line of charge.

E 𝛂 𝐫
E = 

𝛌

𝟐𝛑𝛆𝟎𝐫
 

Electric field due to infinite long charge distribution



Surface charge distribution 𝜎 =
𝑞

𝑆

Cylindrical Gaussian surface

∅E = ׯ 𝐄 ∙ d𝐒 ׯ =
left end

𝐄 ∙ d𝐒+ ׯ
right end

𝐄 ∙ d𝐒+ ׯ
curved surface

𝐄 ∙ d𝐒

∅E =  0+ ׯright end
𝐄. d𝐒+ 0 = E S, 

E S = 
σ S

ε0

Gauss’s law

∅E = ර 𝐄 ∙ d𝐒 =
qenclosed

ε0
 =

σ S

ε0

E = 
𝛔 

𝛆𝟎

Cylindrical  
Gaussian surface

Right end

Curved surface

Left end

E is independent on r

Electric field due to infinite conducting sheet of charge



Volume charge distribution 𝜌 =
𝑞

𝑉

Spherical Gaussian surface with radius r 

∅E ׯ = 𝐄 ∙ d𝐒 = E ׯ dS = E 4πr2  , E 4πr2  = 
q

ε0

Gauss’s law ∅E = ׯ 𝐄 ∙ d𝐒 =
q

ε0
 

E = 
𝟏

𝟒𝛑𝛆𝟎
 ×

𝐪

𝐫𝟐

(i) At a point outside the charged sphere: (r >R)

O+ q

R

P

r

A

Gaussian surface

(ii) At a point on the Surface: (r = R)

Charged 
sphere

O + q

R = 

P

r

A

Gaussian surfaceE = 
𝟏

𝟒𝛑𝛆𝟎
 ×

𝐪

𝐑𝟐

Electric field due to uniformly charged sphere 

Charged 
sphere



Volume charge distribution 𝜌 =
𝑞

𝑉
 = 

𝑞

 
4

3
𝜋𝑅3

Spherical Gaussian surface with radius 𝑟′ 

Gauss’s law ∅E = ׯ 𝐄 ∙ d𝐒 =
q′

ε0
 

E = 
𝟏

𝟒𝛑𝛆𝟎
 ×

𝐪𝐫′

𝐑𝟑

(iii) At a point inside the charged sphere: (𝑟′ < R)

O
+ q ’

R

P ’  

r 
’

A ’ 

Gaussian surface

A 

+ q 

E
dS

Charged 
sphere

Total charge enclosed by Gaussian surface 

q′  = ρV′ =
q

 
4

3
πR3

4

3
πr′3

= q
r′

 R

3

∅E ׯ = 𝐄 ∙ d𝐒 =  E 4πr′2

E 4πr′2
 =

q′

ε0

E 4πr′2
=q

r′

 R

3

Electric field due to uniformly charged sphere 



Charged sphere

Inside sphere On  sphere Outside sphere

E =
1

4πε0
 X

qr

R3

E =
1

4πε0
 X

q

R2

E =
1

4πε0
 X

q

r2

r < R r = R r > R

𝐄 𝛂
𝟏

𝐫𝟐
𝐄 𝛂 𝐫

Graphical representation of Electric field due 
to uniformly charged sphere



Charged cylinder

Inside cylinder Outside cylinder

E =
λ

2πε0r
E =

λ r

2πε0R2

𝐄 𝛂
𝟏

𝐫𝐄 𝛂 𝐫

Electric field due to uniformly charged cylinder 



Summary

▪ Electric charges: Positive, Negative , p = e- = 1.6 X 10-19 C

▪ Unlike charges attracted and like charged repel with each other.

▪ Coulomb's law: F = 
k q1q2

r2 , Electric field strength  E = 
F

q

▪ Electric flux:  ∅E = ׯ 𝐄 ∙ d𝐒 =  E S cos θ

▪ Gauss’s law (Maxwell’s first equation):

     ∅E = ׯ 𝐄 ∙ d𝐒 =
𝐪𝐞𝐧𝐜𝐥𝐨𝐬𝐞𝐝

𝛆𝟎
 , 𝛁. 𝐄 =

ρ

ε0
,  𝛁. 𝐃 = ρ 

▪ Applications of Gauss’s law: 

▪ Electric field due to an infinitely long charge distribution:  E = 
λ

2πε0r
 

▪ Electric field due to an infinitely conducting sheet of charge: E = 
σ 

ε0

▪ Electric field due to uniformly charged sphere : 
       Inside sphere: E =

1

4πε0
 X

qr

R3, On sphere: E =
1

4πε0
 X

q

R2, Out side Sphere: E =
1

4πε0
 X

q

r2

▪ Electric field due to a uniformly charged cylinder:

       Inside sphere:E =
λ r

2πϵο R2, Out side Sphere:  E =
λ

2πϵο r



Worked out examples
1) An infinite line charge produces a field of 9x104 N/C at a distance 
of 2 cm. Find the linear charge density.

Solution:   E = 9x104 N/C , r = 2 cm

     Formula : E = 
𝜆

2𝜋𝜀0𝑟

     𝜆 = 
4𝜋𝜀0𝐸𝑟

2
 = 

9X104x0.02

9x109x 2
 = 0.1 μC/m

Solution:  q = 4x10-8 C , R = 1 cm, r = 2cm  
        r > R (Outside the charged sphere )

    Formula : E = 
𝑞

4𝜋𝜀0𝑟2 

    E = 
9x109x4x10−8

4x10−4  =  9x105 N/C

2) A charge of 4x10-8 C is distributed uniformly on the surface of a 
sphere of radius 1 cm. It is covered by a concentric, hollow 
conducting sphere of radius 5 cm. Find the electric field at a point 
2 cm away from the centre.



QUIZ

Answers: (1Q : b),   (2Q:  a) , (3Q: d), (4Q: d)

1. Q1 and Q2 are 1 Coulomb and r =1 m, ( 
1

4πε0
= 9x109) then the force between 

the charges is             [ ]

(a) 18x109 N  (b) 9x109 N  (c) 0.9x109 N  (d) 10x109 N

2. Eight dipoles of charges of magnitude ‘q’ are placed inside a cube. The total 
electric flux through the cube will be        [ ]

(a) Zero    (b)  
8𝑞

𝜀0
  (c)

16𝑞

𝜀0
  (d) 

𝑞

𝜀0
  

3. Electric intensity at a point varies as r -1 for      [ ]

(a) a point charge   (b) spherically symmetric charge distribution

(c) a plane sheet of charge  (d) a line charge of infinite length

4. Choose the correct graphical representation for Electric field due to a charge 
sphere (E vs r)       [      ]



Student Assignment

1. Explain the concept of electric field.
2. What do you mean by electric flux?
3. State and Prove Gauss’s theorem in Electrostatics. Derive an 

expression for the electric field due to uniformly charged 
sphere.

4. An amount of charge 5x10-6 C is uniformly distributed over a 
sphere with radius 5 cm. what if the electric field of the sphere 
at a point distance of 10 cm from the center?

5. S1 and S2 are two parallel concentric spherical 
       surfaces enclosing charges q and 2q respectively 
       as shown in figure. The ratio of electric flux 
       through S1 and S2 is                       [     ]
       (a) 3 : 1  (b) 1 : 3 (c) 1 : 1  (d) 1 : 2
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Magnetic Induction (B):

F = q (v X B) = q vB sin(θ)

Magnetostatics is the study of magnetic fields in systems where 

the currents are steady (not changing with time). It is the magnetic 
analogue of electrostatics

https://en.wikipedia.org/wiki/Magnetic_field
https://en.wikipedia.org/wiki/Electric_currents
https://en.wikipedia.org/wiki/Steady_current
https://en.wikipedia.org/wiki/Electrostatics


Magnetic field intensity (H)

Units : A/m, Oersted

Magnetic flux density or 

Magnetic induction (B)

𝑩 = 𝝁𝑯

𝝁0= permeability of free space 

𝝁0 = 4π x 10−7 T.m/A

Units:   M.K.S

1 Tesla = wb/𝑚2 = N/(A.m)

C.G.S

1 Gauss 

1 Tesla = 1 wb/ 𝒎𝟐 = 𝟏𝟎𝟒 

Gauss 

Orested experiment: Current carrying conductor produces a magnet.



Magnetic flux
The number of magnetic field lines passing normally through any 
surface placed inside electric field is called electric flux.

∅B = ර B ∙ d𝐒

∅E =  B S cos θ

Units: 

weber (wb), Tesla. m2 

Scalar quantity

Magnetic field lines are closed loops. 
Started at North Pole and ends at South Pole.
Mono Poles does not exists in magnets

𝜵. 𝐁 = 𝟎 
Gauss law In Magnetostatics  
Maxwell’s Second equation.



BIOT-SAVART LAW
Orested experiment: Current carrying conductor produces a magnet.
BIOT –SAVART obtained relation for B.

𝑑𝑩 =
𝜇0 
4π

x
i dl x 𝒓

𝑟3  (Vector form)𝑑𝑩 =
𝜇0 

4π
x

i dl sinθ

𝑟2

Direction of B:
Direction of dB will be perpendicular to the plane 
containing dl and r. (Right hand thumb rule).

If magnetic field is directed perpendicular and into 
the plane of the paper, then it is represented by 
cross.
If magnetic field is directed perpendicular and out of 
the plane of the paper, then it is represented by dot.



Magnetic field due to Long straight 

conductor (current carrying wire)

𝑩 =
𝝁𝟎 i

2πR

Concentric circles



Magnetic field on the axis of a circular loop

𝑩 =
𝝁𝟎 𝑵𝒊

2a

Consider a circular coil of radius a and carrying a current i.  
Magnetic field at P point which is on the axis of the coil 
distance x from the centre.

𝐵 =
𝜇0 𝑁𝑖𝑎2

2(𝑎2 + 𝑥2)3/2

Magnetic field at the centre of coil

Magnetic field induction due to a solenoid

A long, tightly wound helical coil of wire id called as solenoid

𝑩 =
𝝁𝟎 𝑵𝒊

𝒍
 = 𝝁𝟎 𝒏𝒊Magnetic field at the centre of solenoid

𝑩 =
𝝁𝟎 𝒏𝒊

𝟐
Magnetic field at an axial end point



Force on a point charge in magnetic field

F = q (v x B) = qvB sin 𝛉

1) Particle is at rest , F =0

2)  Particle is moving along the line of magnetic 

field, F  = 0

3) Particle is moving along the line of magnetic field, 

F  = maximum

4) In magnetic field, the work done by the force 

acting on the charged particle is zero.

5) When a charged particle enters a magnetic field in 

a direction perpendicular to the field, it takes a 

circular path in the field.

𝑎𝑛𝑔𝑢𝑙𝑎𝑟 𝑣𝑒𝑙𝑜𝑐𝑖𝑡𝑦 𝑤 =
qB 

𝑚
𝐶𝑦𝑐𝑙𝑜𝑡𝑟𝑜𝑛 𝑓𝑟𝑒𝑞𝑢𝑒𝑛𝑐𝑦 𝑓 =

qB 

2π𝑚𝑟𝑎𝑑𝑖𝑢𝑠 𝑟 =
mv 

𝑞𝐵



Ampere’s law

Line integral of magnetic field B along a closed curve is equal to 𝜇0 time 

the net current I through the area bounded by the curve

ර 𝐁 ∙ d𝐥 = 𝜇0𝑖 (Inegral form)

𝛁 x 𝐁 = μ0 𝐉 (Differential form) 

𝐶𝑢𝑟𝑟𝑒𝑛𝑡 𝑑𝑒𝑛𝑠𝑖𝑡𝑦 𝐽 =
𝑖

𝐴
, 

 𝑈𝑛𝑖𝑡𝑠:
𝐴

𝑚2  ,Vector

 ර 𝐉 ∙ d𝑺 = 𝑖 

Maxwell’s Third equation

Magnetic field due to Long straight conductor (current carrying wire) 𝑩 =
𝝁𝟎 i

2πR

𝑩 =
𝝁𝟎 𝑵𝒊

2aMagnetic field at the centre of coil

𝑩 =
𝝁𝟎 𝑵𝒊

𝒍
 = 𝝁𝟎 𝒏𝒊Magnetic field at the centre of solenoid



Self inductance of Long solenoid

∅B = 𝐵𝐴, ∅B = Li 𝑩 =
𝝁𝟎 𝑵𝒊

𝒍
 = 𝝁𝟎 𝒏𝒊

L=
𝜇0𝑁2𝐴

𝑙
= 𝜇0𝑛2𝐴l

𝑛 = 𝑁𝑢𝑚𝑏𝑒𝑟 𝑜𝑓 𝑡𝑢𝑟𝑛𝑠 𝑝𝑒𝑟 𝑢𝑛𝑖𝑡 𝑙𝑒𝑛𝑔𝑡ℎ = (𝑁/𝑙)
Length of coil (l), Number of turns in the coil (N)
Cross – sectional area of the coil (A)

Energy density in Magnetic field

u = 
𝑈

𝑉
=

1

2

𝐵2

𝜇0
 ( J/m3)

Units:  Henry (H)



Force on a current carrying conductor

F = i (l x B) = ilB sin 𝛉

𝑭𝟏𝟐 = 𝑭𝟐𝟏 =
𝝁𝟎𝒊𝟏𝒊𝟐

𝟐𝝅𝒅

Fleming’s left hand rule
Fore finger : Induction finger : Field (B)
Central finger: Current (i)
Thumb: Force: Thrust (F)

Force between two parallel conductors

Two parallel wires carrying current 
in the same direction attract.
Two parallel wires carrying current 
in the opposite directions repel.

Torque on a current loop in 
Uniform Magnetic field:

𝜏 = 𝑖 𝑁 𝐴𝐵 sinθ = 𝑁 𝑖 𝑨 𝑋 𝑩
𝜏 =  𝑴 𝑋 𝑩



1) A long straight wire carries a current of 3.5 A. Find the magnetic 

induction at a point 0.2 m from the wire.  [3.5 ∗  10−6 A/m] 

2) An infinitely long conductor carries a current of 10 mA. Find the 

magnetic field and intensity at a point 10 cm away from it.

 [2 ∗  10−8 A/m, 0.01591 A/m]

3) A current of 1 A is flowing in a circular coil of radius 10 cm and 20 

turns. Calculate the magnetic field at the centre. [4π x 10−7 wb/ 𝑚2]

4) If two parallel conductors separated by 20 cm in free space carry 20 A 

and 40 A currents respectively, determine magnetic induction at mid-point 

of line joining the conductors. [8 x 10−4 N/m]

5) Calculate the energy stored in the magnetic field of a solenoid of 

inductance 5 mH, when a maximum current of 3 A flows through it. 

[ 22.5 x 10−3 J]

Assignment



6) A circular coil of wire of diameter 10 cm and having 10 turns carries a current of 1 A. If it is 

placed in a uniform magnetic field of induction 0.5 T, calculate the maximum torque on the 

coil. [0.3928 N.m]

7) At what distance from a long straight wire carrying a current of 12 A will the magnetic 

induction be equal to 3 x 105 T?  [ 8 x 10−12 m]

8) Find the energy stored in the magnetic field of a solenoid of inductance 5 mH, when a 

maximum current of  2 A flows through it. [ 0.01J] 

9) Find the intensity of magnetic field at the center of a circular coil of radius 20 cm and 20 

turns having a current 1 A in it.        [B]

(A) 200 A/m   (B) 100 A/m  (C) 10 A/m  (D) 20 A/m

10) A rectangular loop carrying a current ‘I’ is situated near a long straight wire such that the 

wire is parallel to one of the sides of the loop and is in the plane of the loop. If steady current I  

established in the wires as show in figure, the loop   [C]

(A)rotate about an axis parallel to wire (B) move away from the wire

(C) move towards the wire    (D) remains stationary

Assignment



1) In terms of the basic units of mass (M), length (L) time (T) and charge (Q), the dimensions of magnetic 

permeability of vacuum (µ0) are             (JAM -2007)

(A)MLQ-2  (B) ML2T-1Q-2   (C) LTQ-1  (D) LT-1Q-1

2) Two long, parallel straight conducting wires carry the same current in the same direction. If the distance 

between them is halved and the current in both is doubled, the force per unit length between them will 

change by a factor of                (JAM -2007)

(A)1/8   (B) 8   (C) 4   (D) 1/4

3) Two long straight parallel wires are carrying current of same magnitude I, but in opposite direction. If the 

wires are separated by a distance d, then magnetic field at the middle of the separation is  (JAM -2011)

4) In terms of the basic units of mass (M) , length (L) time (T) and charge (C), the dimensions of magnetic 

induction field (B) is                  (JAM -2013)

(A) ML2T-1C-1  (B) MT-1C-1  (C) L2T-1C  (D) L-1T-1C

Previous JAM questions

Answers: (1Q : A),   (2Q:  B) , (3Q : D), (4Q : B)



BEST OF LUCK

THANK YOU
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X-RAY DIFFRACTION (XRD)

•  Introduction 

•  diffraction

•  Electromagnetic spectrum

•  Reason for X-rays

•  X-Ray Diffraction (XRD)

•  Bragg’s law 

•  x-ray diffraction methods

•  Applications of XRD

•  Advantages and disadvantages

•  Scope of research, references

Objectives



XRD

SOLUTION

Unknown material

Finger Print

SOLUTION

Identify

Crystal
Structure
Properties

Introduction



X –Ray Diffraction (XRD): 

▪  Novel and Non-destructive technique

▪  Finger print of substance

▪  Provides detailed information about 

    crystallographic structure, chemical  

    composition, physical properties of materials

XRD – Thin film (600 nm)

XRD Measure:
• Average spacings between layers of rows of atoms in a 

substance

• Determine the orientation of an individual grain or 

crystal

• Measure the size, shape and internal stress of small 

crystalline areas

• Identify the crystal structure of an unknown substance.

X-Ray Diffraction (XRD)



Wilhelm Roentgen

Nobel Prize : 1915

German Physicist

Max Von Laue

History

Nobel Prize : 1915

German Physicist

X- Rays X-Ray Diffraction



Diffraction
Bending nature of light around the corners of 
aperture.

Diffraction, Interference characterizes wave 
nature of  light.

Diffraction in every day example:
Blue butterfly

Condition for Diffraction:

sinθ ~ λ/d

Wavelength of light ~ Size of Aperture

Application of Diffraction:
✓ Hologram

✓ Spectroscopy

✓ X-Ray Diffraction (XRD)

http://blog.vikramank.com/wp-content/uploads/2015/07/blue-butterfly.jpg


Electromagnetic spectrum

X-Rays Short Wavelength : 0.1 A0 to 100 A0

E= hf = hc/λ

High energy: 100 eV to 100 keV 
Hard X-Rays

Soft X-Rays



REASON FOR X-RAYS

Wavelength of X- rays ~ Crystalline size

XRD



BRAGG’S LAW

2d sinθ = nλ  

d = Interplanar distance in crystal

λ= Wavelength of X-rays

θ = Angle of incidence

Condition for Constructive 

interference:

Path difference = nλ

AB +BC = nλ

AB = BC = d sinθ



X-Ray Diffraction Methods

X- Ray Diffraction Method

Orientation

Single Crystal

Polychromatic Beam

Fixed Angle

Laue Rotating crystal Powder

Lattice Parameters

Polycrystal (powdered)

Monochromatic Beam

Variable Angle

Lattice constant

Single Crystal

Monochromatic Beam

Variable Angle

2d sinθ = nλ  



Joint Committee on Powder Diffraction Standards (JCPDS)- XRD

XRD – Silicon (Si)XRD – Antimony  (Sb)

XRD

SOLUTION

XRD  

Antimony

Unknown 

material
Antimony



Applications of XRD

▪  Structural properties: Lattice parameters (10 - 4A0 ), strain, grain size.

▪  Particle size determination

▪  determination of unit cell dimensions

▪  measurement of sample purity 

▪  Study of corrosion products

▪  Examination of tooth enamel and dentine

▪  Examination of bone state and tissue state

▪  Structure of DNA and RNA

▪  Pharmaceutical industry

▪  Forensic science

▪  Geological applications

▪  Microelectronics industry

▪  Glass industry



Advantages and Disadvantages

Advantages:

•  Least expensive, the most convenient.

•  Widely used method to determine crystal structures.

•  Best method for Phase analysis.

•  X – Rays are not absorbed very much by air, so the sample need not   

   be in an evacuated chamber.

Disadvantages:

o  X-Rays do not interact very strongly with lighter elements.

o  Intensity is 108 times less than that of electron diffraction.



SCOPE OF RESEARCH

References:
https://www.scimed.co.uk/education/what-is-x-ray-diffraction-xrd/

https://www.slideshare.net/gopinathkarnam/x-ray-diffraction-25472126

https://www.slideshare.net/bharathpharmacist/81347482-xraydiffractiontechnique-39635806

https://www.slideshare.net/jaimini26/x-ray-diffraction-and-applications

https://serc.carleton.edu/research_education/geochemsheets/techniques/XRD.html

https://www.sciencedirect.com/topics/engineering/x-ray-diffraction

Crystal structures using Rietveld refinement

Modal amounts of minerals (quantitative analysis)

Characterize thin films samples by:

• determining lattice mismatch between film and substrate

• determining dislocation density and quality of the film by rocking curve measurements

• measuring superlattices in multi-layered epitaxial structures

• determining the thickness, roughness and density of the film using glancing incidence X-

ray reflectivity measurements

https://www.scimed.co.uk/education/what-is-x-ray-diffraction-xrd/
https://www.slideshare.net/bharathpharmacist/81347482-xraydiffractiontechnique-39635806
https://www.slideshare.net/jaimini26/x-ray-diffraction-and-applications


Important points

▪ X-ray diffraction, or XRD, is a technique for analysing the atomic or 

molecular structure of materials.

▪ It is non-destructive, and works most effectively with crystalline 

materials.

▪ It act as a finger print of substance.

▪ Diffraction is bending nature of light as it passes around obstacle or 

aperture.

▪ The degree to diffraction occurs depends on the relative size of a 

wavelength compared to the dimensions of the obstacle or aperture.

▪ XRD will only occur if the way the x-rays and substance interact meets 

the conditions of Bragg’s law. 

❖     The angle of incidence is equal to the angle of scattering.

❖     The path length difference is equal to an integer number of 

        wavelengths.
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Academic (Higher Education) 

Prospects

Job Prospects Other 

Opportunities
● M. Sc. (Physics) in IITs, NITS, IISc 

(Bangalore), TIFR, JNU, IISER, IIST, 

Central Universities, State 

Universities 

● Integrated M.Sc. (M.Sc.+ Ph.D.) 

●  Integrated M.Tech 

● Ph.D. (Research)

● Researcher (UGC-NET / 

CSIR/GATE/JEST/State Eligibility 

Test).

● Abroad after qualifying GRE/TOEFL

● Professor/Lecturer/Academician

● Research Assistant

● Researcher

● Lab technician and 

● Scientist in 

ISRO, DRDO, ONGC, BARC, TIFR

● Scientist in Saha Institute of Nuclear 

Physics

● Scientist in Nuclear Science Centre

● Scientist in Physical Research 

Laboratory

● Geo Scientist 

● Radiologist

● Consulting 

Physicist

● Content 

Developer

● Technical 

assistant 

Scope of Science for future employment 



 Jobs in government organizations like DRDO, BARC, VSSC, 

ISRO, BHEL, NTPC, SSPL, etc.

 Lecturer jobs in teaching field.

 Jobs in private field like software engineer.

 Laboratory assistant.

Brief about CAREER OPPORTUNITIES WITH  PHYSICS



Higher Education and Employment Opportunities in Physics 

➢  All Central Universities and leading State Universities offer Post Graduate and 

Doctoral programme in Physics. Several leading private universities also offer master’s 

in Physics. 

➢  The teaching of Physics in distance education mode at graduation, post graduation and 

doctoral level is offered by IGNOU and several other universities recognized by 

Distance Education Council. 

➢  Post graduate and doctoral programme in Physics is also offered by all IITs, IISc., 

TIFR and JNU. Admission to these programmes is through Joint Admission Test to 

M.Sc (JAM) or through Institute level entrance tests/interviews. 

➢  Admissions to Doctoral Programme are on the basis of NET/GATE combined with 

institute level tests/interviews. Several National Institutes of Technology also offer 

Masters in Physics/Applied Physics. 

➢  Student can join research institutes like ISRO, DRDO, TIFR etc.. for higher studies as 

well as job opportunities

Brief about Higher education



▪ Indian institute of technology  (IITs) .. Total – 23

▪ Indian Institute of Science (IISc) Bangalore

▪ Joint Entrance Screening Test (JEST)

▪ National Institute of Technology (NITs) – Total 31

▪ Top Notch : Trichy, Rourkela, Surathkal, Warangal, Calicut

▪ Indian Institute of Space Science & Technology (IIST), Trivandrum

▪ Indian Institutes of Science Education and Research (IISER) ( Berhampur, 

Bhopal, Kolkata, Mohali, Pune, Thiruvananthapuram and Tirupati

▪ Banaras Hindu University (BHU)

▪ University of Delhi (DU)

▪ UoH - University of Hyderabad

Top notch IITs universities which can offer Physics higher education:



Top notch IITs which can offer Physics higher education:

❖ Indian Institute of Technology (IIT) Bombay

❖ Indian Institute of Science (IISc) Bangalore

❖ Indian Institute of Technology (IIT) Madras

❖ Indian Institute of Technology (IIT) Delhi

❖ Indian Institute of Technology (IIT) Kanpur

❖ Indian Institute of Technology (IIT) Hyderabad

❖ Indian Institute of Technology (IIT) Kharagpur

IIT jam is a joint admission test conducted by IITs and IISC for admission 

into MSc, integrated PhD, MSc PhD dual degree, joint MSc PhD courses. 

Many IISERs and NITs are also taking admission into their MSc courses 

based on JAM score.

Brief about IIT- JAM



IIT JAM 2021 Exam Pattern Highlights
Particulars Details

Exam Mode Online, Computer Based (CBT)

Exam Duration 3 hours

Test language English

Type of Questions MCQs, MSQs, NAT

Subjects Economics, Chemistry (CY), Physics (PH), Mathematics (MA), Geology 

(GG), Mathematical Statistics (MS), and Biotechnology (BT)

Total Questions 60

Total Marks 100 Marks

MCQ: Multiple Choice Question, MSQ: Multiple Selective Question, NAT: Numerical Answer Type

Brief about IIT- JAM

IIT JAM 2021 Exam Question Paper Pattern
Particulars Question range Carry marks Max Marks Negative marks

SECTION-A (MCQS) (1-10) One mark 10 1/3

(11 -30) Two marks 40 2/3

SECTION-B (MSQs) (31-40) Two mark 20 Not applicable

SECTION- C (NAT) (41-50) One mark 10 Not applicable

(51-60) Two marks 20 Not applicable



IIT- JAM – Physics: Cut off particulars

Year GEN OBC (NCL) SC/ST/PWD

2021 19.91 17.92 9.96

2020 21.70 19.53 10.85

2019 24.99 22.49 12.49

2018 17.05 15.35 8.53

2017 14.79 13.31 7.39

Brief about IIT- JAM- Physics

IIT- JAM- Physics: Topic wise weightage

Topic Mecha

nics

EMT Modern 

Physics

Mathematical 

Physics

Oscillations, 

Waves & 

Optics

Thermal 

Physics

SSP & 

Electronics

Avg (%)

[2005 – 2018]

16.57 18.21 15.64 11.64 11.79 13 13.14



Mode of the Exam Offline

Medium
English (Except the language 

papers)

Total Papers 1

Sections 2: Part A and Part B

Types of Question Objective Type (MCQ)

Duration of the Exam 2 Hours

Total Questions 75

Total Marks 100

HCU:
Paper Pattern 
Section A : Objective type questions of one mark each. There is negative marking of 0.33 mark 
for every wrong answer.
The marks obtained by the candidate in this section will be used for resolving the tie cases.
Section B: 50 Objective type questions of one and a half mark each. There is no negative 
marking in this section.

Brief about HCU



Brief about HCU

Syllabus: Physics (Mechanics, General properties of matter, Kinematics, heat 

and thermodynamics. Wave motion, electricity and magnetism , light , modern 

physics, electronics and measurements ) 

and mathematics

(algebraic equations, differential and integral calculus including limits , 

vectors, matrices and determinates, elementary differential equations and 

elementary functions and their graphs)

Cut off:

HCU Doesn't declare cutoff for Msc physics. In 2019 those students with 

[60+] marks got Selected in HCU. So those students who got [50+] were also 

Selected as paper difficulty and no calculator was allowed in 2020. All the 

above cutoff was for general candidate.



Common Postgraduate Entrance Test

Brief about CPGET

Exam Osmania University Common 
Entrance Test

Duration 90 minutes (One Hour and 
Thirty Minutes)

Mode of the exam Online

Type of questions Multiple choice questions 
(MCQs)

Total marks 100

Number of questions 100

Marking scheme 1 mark for every correct 
answer; No negative marking



Rank   Marks

Brief about CPGET



K. SPANDANA
HOD, Department of Physics

TSWRAFPDCW, Bhongir

Venue: PG Entrance coaching class

Date: 22-05-2021

Time: 2.00 m – 3.30 pm 

TSWREIS
PAPER: ELECTROMAGNETIC THEORY 

TOPIC: ELECTROSTATICS



IIT JAM 2021 Exam Pattern Highlights
Particulars Details

Exam Mode Online, Computer Based (CBT)

Exam Duration 3 hours

Test language English

Type of Questions MCQs, MSQs, NAT

Subjects Economics, Chemistry (CY), Physics (PH), Mathematics (MA), Geology 

(GG), Mathematical Statistics (MS), and Biotechnology (BT)

Total Questions 60

Total Marks 100 Marks

MCQ: Multiple Choice Question, MSQ: Multiple Selective Question, NAT: Numerical Answer Type

Brief about IIT- JAM

IIT JAM 2021 Exam Question Paper Pattern
Particulars Question range Carry marks Max Marks Negative marks

SECTION (MCQS) (1-10) One mark 10 1/3

(11 -30) Two marks 40 2/3

SECTION-B (MSQs) (31-40) Two mark 20 Not applicable

SECTION- C (NAT) (41-50) One mark 10 Not applicable

(51-60) Two marks 20 Not applicable



IIT- JAM – Physics: Cut off particulars

Year GEN OBC (NCL) SC/ST/PWD

2021 19.91 17.92 9.96

2020 21.70 19.53 10.85

2019 24.99 22.49 12.49

2018 17.05 15.35 8.53

2017 14.79 13.31 7.39

Brief about IIT- JAM- Physics

IIT- JAM- Physics: Topic wise weightage

Topic Mecha

nics

EMT Modern 

Physics

Mathematical 

Physics

Oscillations, 

Waves & 

Optics

Thermal 

Physics

SSP & 

Electronics

Avg (%)

[2005 – 2018]

16.57 18.21 15.64 11.64 11.79 13 13.14



▪ Introduction to Electrostatics and examples

▪ Basic properties of Electric charges 

▪ Coulomb’s law

▪ Electric field and electric field lines 

▪ Electric flux 

▪ Gauss’s law (Integral and differential forms)

▪ Application to linear, plane and spherical charge distributions

▪ Conservative nature of electric field E, irrotational field

▪ Electric Potential, Relation between electric potential and electric field

▪ Potential energy of a system of charges, Energy density in an electric field

▪ Electric potential for various systems.

▪ Torque acting on an Electric Dipole placed in uniform electric field

▪ Applications

▪ Summary

▪ Previous year questions, Quiz 

OBJECTIVES



Electrostatics is a branch of physics, which deals with the 

phenomena and properties of stationary or slow-moving electric charges.

Every day life examples of 

Electrostatics:

INTRODUCTION

❖ Attraction of paper to charged comb.

❖ Rubbing balloons on hair and 

sticking to the wall 

❖ Thunder and Lighting. 

❖ Photocopier & laser printer operation 



Every substance is made up of atoms.

Atom consists of Electrons ,Protons, Neutrons.

Mass Charge

Electron 9.1 X 10-31 kg - 1.6 X 10-19 C

Proton 1.673 X 10-27 kg +1.6 X 10-19 C

Neutron 1.675 X 10-27 kg 0

Charge: Scalar quantity,  Units: Coulomb (C), Dimensional formula : [AT]

ELECTRIC CHARGE

o Protons  : Positive charge
o Electron : Negative charge
o Neutron : Zero charge

Properties of charge:
❖ Charge quantization:  Q = +/- ne (n is integer)
❖ Charge is conserved:  
Electric charge can neither be created nor be destroyed
❖ Additivity of charges: 
Total charge of a body is the algebraic sum of all the charges on body.



Topic: Electric charge

1) What is the charge of Lithium Nucleus?

Worked out Examples-I

Solution: Li atomic number = 3, Number of Protons n = 3

   Charge of Proton e = 1.6x10-19 C

   Q = ne  = 3x 1.6 x10-19 = 4.8 x 10-19 C

2) When 1019 electrons are added to the neutral material, then the 

 electric charge present on it will be      [  ]

     (a) - 16 C  (b) + 16 C  (c)  - 1.6 C  (d)  + 1.6 C

Solution:

   n = 1019, Charge electron e = 1.6x10-19 C

   Q = ne  = 1019 x 1.6 x10-19 = 1.6 C

   Electrons are added to material , so it get negative charge

   Answer : (c) 



1. What is the charge of Gold nucleus?

2. How many number of electrons added to isolated conductor to get  

      charge on its surface is 3.2 x10-18 C? 

3. What is the charge of nucleus with atomic number 4?

4. How many electrons are there in one coulomb of charge?     [  ]

    (a) 6.023x1023  (b) 6.023x1020   (c) 6.023x1018  (d) 6.023x1015 

5.When 1020 electrons are removed from the neutral material, then 

    the electric charge present on it will be         [  ]

    (a) - 16 C   (b) + 16 C    (c)  - 1.6 C   (d)  + 1.6 C

Assignment -I

Answers: (1Q : 126.4 x10-19 C),   (2Q:  20) , (3Q: 126.4 x10-19 C),(4Q: c), (5Q: b)

Topic: Electric Charge



Unlike charges attract with each other

How  do charge behaves?

Unlike charges Attracts each other-+

Like charges repel Like charges repel- - + +

Like charges repel with each other



The force of attraction or repulsion between two electric point 

charges is directly proportional to the product of the magnitude 

of  charges and inversely proportional to the square of the 

distance between the two charges.

F = 
𝒌 𝒒𝟏𝒒𝟐

𝒓𝟐

k =
1

4𝜋𝜀𝑜
 = 9X109 Nm2/C2 

ε0 = 8.85x10-12 C2 /Nm2 (F/m) 

COULOMB’S LAW

Electric force units: Newton (N)

It is a Vector quantity



The region around the electric charges where 

another charge when placed will experience a force 

of attraction or repulsion is called an Electric field.

ELECTRIC FIELD

Electric field intensity E = 
𝑭

𝒒

Electric field lines: 

❖The tangent drawn at any point on the electric field line gives 

the direction of electric field at that point.

❖ Electric field intensity at any point defined as number electric 

field lines passing through unit area round that point normally.

Units: N/C, V/m, Vector quantity
A B

𝑬𝑨 > 𝑬𝑩



Properties of electric field lines

I- Single positive charge 

(Radially outward)

II- Single negative charge 

(Radially inward)
IV - Equal positive and 

negative charge

III- Two equal 

positive charges

❖ Electric lines of force are perpendicular to the surface of a positive or negative   

      charged body.

❖  Electric field lines are closer where electric field is very strong and spread out    

      when electric field is weaker. 

❖  The electric lines of force start from positive charge and end on negative charge.

❖  The lines of force have a tendency to contract in length. This explains the    

      attraction between opposite charges.

❖  The field lines never intersect each other. Two tangents can be drawn, i.e., two  

      directions of force are impossible at one point.



Intensity of electric field due to a point charge

E = 
F

𝑞0
 

F = 
𝑘 𝑞𝑞0

𝑟2

E = 
𝟏

𝟒𝝅𝜺𝒐
(

𝒒

𝒓𝟐)

Electric field due to multiple charges: 

E = E1 + E2 + E3 + E4………. + En  (Vector sum)

+q +𝑞0
r

F

E
P



1) The position vectors of two equal charges of 1 μC each are (i + j + k)m and (2i + 3j -k) m. 

    What is the magnitude of electrostatic force between them?

Topic: Coulomb force and Electric field intensity

Worked out Examples-II

Solution: q1 = q2 = 1 μC , 

    r = r2-r1 = (2i+3j-k) – (i+j+k) =  (i+2j-2k),  r = 3 m

    F = 
𝐾 𝑞1𝑞2

𝑟2  = 
9∗109 1∗10−6 2

 

32  = 10-3 N

2) Find the force experienced by a chloride ion having 4 electrons removed, when placed in 

    an electric field of intensity 2 N/C.

Solution: q = ne = 4e ,  E = 2 N/C

    F = Eq = 2x4x1.6X10-19 = 12.8 X10-19 N

3) If the electric field is uniform, then             [     ]
(a) Its magnitude is same but direction is not same (b) Its magnitude is not same but direction is same

(c) Its magnitude and direction remains same          (d) Its magnitude and direction are not same

Answers: (c)



4) A proton and an electron are place in a uniform electric field       [     ]
    (a) Their acceleration will be equal          (b) The magnitudes of their acceleration will be equal

    (c) The electric force acing on them will be equal (d) The magnitude of forces will be equal

Worked out Examples-II

Topic: Coulomb force and Electric field intensity

Solution:  qe = qp , Ee = Ep , F = Eq , Fe = Fp 

    Electron and proton has opposite charges Fe ≠ തFp

     a = F/m , me ≠ mp , ae ≠ ap

    Answers: (d)

5) Two identical metal spheres posses +60 C and -20 C of charges. They are brought in

contact and the separated by 10 cm. Find the force between then?

Solution: Q1 = +60 C , Q2 = -20 C , r = 10 cm = 0.1 m 

   When two spheres are brought in contact then the net charge on each 

   𝑞1 = 𝑞2 =
𝑄1+𝑄2

2
 = 

60− 20

2
 = + 20 C

   F = 
𝐾 𝑞1𝑞2

𝑟2  = 
9𝑋109 (20𝑋20) 

0.12  = 36 x 1013 N



1) Two equal charges of 2 μC each are located at points (1 , 3, 3) and (3, 4, 1) . The distance is in 

meters. The magnitude of electrostatic force (in newton) between them is      [ ]

     (a) 4x10-3      (b) 2x10-3       (c) 4.5x10-4   (d) 9x10-4 

2) A charge ‘q’ is placed at the center of line joining two equal charges + Q. The system of the 

three charges will be equilibrium if the charge q is equal to         [ ]

     (a) –Q/2    (b) +Q/2    (c) –Q/4    (d) +Q/4 

3) The force experienced by an atom having 5 electrons removed, when placed in an electric field 

of intensity  3 N/C is               [ ]

     (a) 24x10-19 N  (b) 32x10-19 N   (c) 6.4x10-19 N   (d) 1.6x10-19 N

4) Two identical metallic sphere A and B carry charge +q and -2q respectively. The force between 

them is F  when they are separated by a distance ‘d’ in air. The spheres are allowed to touch each 

other and are moved back to their initial positions. The force between them is now equal to [ ]

     (a) F     (b) F/2     (c) F/4     (d) F/8

5) At what separation should two equal charges 1 C each be placed so that the force between them 

equals the weight of 25 kg person? (Take g = 10 m/s2)          [ ]

 (a) 8.6x103 m  (b) 6 x103 m   (c) 4.5 x103 m   (d)  3.6x103 m

Topic: Coulomb force and Electric field intensity

Assignment-II

Answers: (1Q : a),   (2Q:  c) , (3Q: d), (4Q: b)



Limitations of Coulomb’s Law 

GAUSS’S LAW

❑ Coulomb’s law is valid for point charges only. 

❑ It is valid only for static charges. 

❑ It is valid only up to nuclear distance of 10-15 m.

❑ It is complex to deal with charges having irregular shapes.

❑ It is difficult to apply Coulomb’s law when the charges are 

in an arbitrary shape. 



Electric flux
The number of electric field lines passing normally through any 
surface placed inside electric field is called electric flux.

∅𝐸 = ර 𝑬 ∙ 𝑑𝑺

∅𝐸  =  E S cos 𝜃

The electric flux through an area is defined 
as the electric field multiplied by the area 
of the surface projected in a plane 
perpendicular to the field.

Units: N.m2 /C, Scalar quantity



Electric flux depending factors

❑  Electric flux is proportional to the density 
of flow (E).

❑  Electric flux varies by how the      
boundary faces the direction of flow (𝜽).

❑  Electric flux is proportional to the         
area within the boundary (S).

∅𝑬 =  E . S= E S cos 𝜽

(A)

(B)

(C)



(c)  = EA cos 𝜽(a)  = EA (b)  = 0

Calculate the flux of the electric field E, through 

the surface A, in each of the three cases shown



d = E dS cos  = E . dS

 dS

E
S

 =  d =  E . dS

What if the surface is curved, or the field varies with position ??

In the case of a closed surface

❖Flux is positive for field lines that leave enclosed 

volume

❖Flux is negative for field lines that enter enclosed 

volume

If a charge is outside a closed surface, the net flux is zero.

As many lines leave the surface, as lines enter it.

∅𝑬 = ර 𝒅∅ = ර 𝑬 ∙ 𝒅𝑺 
dS

E



2q charge is out of closed surfaces c, d.

Net electric flux is zero for surfaces c and d. 

For which of these closed surfaces (a, b, c, d) the flux of 

the electric field, produced by the charge +2q, is zero?



Gauss Law states that total normal electric flux 

∅E over a closed surface is (1/ε0 )times the total 

charge q enclosed within the surface.

ර 𝐄 ∙ d𝐒 = ර 𝐄. d𝐒𝐜𝐨𝐬θ

∅𝐄 = ර 𝐄 ∙ 𝐝𝐒 =
𝐪𝐞𝐧𝐜𝐥𝐨𝐬𝐞𝐝

𝛆𝟎
 

Gauss’s law

Differential form of Gauss’s law 

𝛒 = volume charge density, 𝐪 = 𝛒׮  𝐝𝐕 

Gauss divergence theorem  

ׯ 𝐄 ∙ d𝐒 ׮ = 𝐝𝐢𝐯𝐄 𝐝𝐕  

Electric displacement vector D = ε0E 

𝛁. 𝐄 =
𝛒

𝛆𝟎
,  𝛁. 𝐃 = 𝛒 

Integral form of Gauss’s law 

*Maxwell’s First equation*

∅𝐄 =
𝐪𝐞𝐧𝐜𝐥𝐨𝐬𝐞𝐝

𝛆𝟎



Surface a, a =
+ 𝟐𝐪

𝛆𝟎
 

Calculate the flux of the electric field 

for each of the closed surfaces a, b, c, and d

Surface d, d = 
− 𝐪

𝛆𝟎

Surface c, c = 0

Surface b, b =
+ 𝐪

𝛆𝟎

Gauss’s law: ∅𝐄 =
𝐐𝐞𝐧𝐜𝐥𝐨𝐬𝐞𝐝

𝛆𝟎



Linear charge density:  𝜆 =
𝑞

𝑙

Units: C/m

Surface charge density:  𝜎 =
𝑞

𝑆

Units: C/m2 

Volume charge density:  𝜌 =
𝑞

𝑉

Units: C/m3

Various Charge distributions

Applications of Gauss’s law

dq



Problem solving strategies for Gauss’s law

Select a 

Gaussian 

surface with 

symmetry 

that matches 

charge 

distribution

Draw Gaussian 

surface so that 

electric field is 

either constant 

or zero at all 

points on the 

Gaussian surface

Use symmetry 

to determine 

direction of E 

on Gaussian 

surface

Evaluate 

surface 

integral  

(Electric 

flux)

Determine 

the charge 

inside the 

Gaussian 

surface

Solve for 

Electric 

field



How to select suitable  closed Gaussian surface ?

Cylinder SphereCube

Plane charge distribution: 
Infinite line of charge 

Surface charge distribution: 
Infinitely sheet of charge

Volume charge distribution: 

Charged Sphere 



Electric field due to an infinitely long charge distribution

Linear charge distribution 𝜆 =
𝑞

𝑙

Gaussian surface:  coaxial cylinder 

of length l and radius r 

∅E = ׯ 𝑬 ∙ 𝒅𝑺 𝑙𝑒𝑓𝑡 𝑒𝑛𝑑ׯ =
𝑬 ∙ 𝒅𝑺+ ׯ𝒓𝒊𝒈𝒉𝒕 𝒆𝒏𝒅

𝑬 ∙ 𝒅𝑺+ ׯ𝒄𝒖𝒓𝒗𝒆𝒅 𝒔𝒖𝒓𝒇𝒂𝒄𝒆
𝑬 ∙ 𝒅𝑺

∅E =  0+0 + +ׯ𝑐𝑢𝑟𝑣𝑒𝑑 𝑠𝑢𝑟𝑓𝑎𝑐𝑒
𝐸. 𝑑𝑆 = E. 2𝜋𝑟𝑙 ,  

 E. 2𝜋𝑟𝑙 =  
 𝜆𝑙

 𝜀0
 

Gauss’s law

∅E = ර E ∙ dS =
qenclosed

ε0
 =

λl

ε0 Cylindrical  Gaussian surface

Right end

Curved surface

Left end

Graphical representation of electric field 

due to a infinity long line of charge.

E 𝜶 𝒓

E = 
𝝀

𝟐𝝅𝜺𝟎𝒓
 



Electric field due to an infinitely conducting sheet of charge

Surface charge distribution 𝜎 =
𝑞

𝑆

Cylindrical Gaussian surface

∅E = ׯ 𝑬 ∙ 𝒅𝑺 𝑙𝑒𝑓𝑡 𝑒𝑛𝑑ׯ =
𝑬 ∙ 𝒅𝑺+ ׯ𝒓𝒊𝒈𝒉𝒕 𝒆𝒏𝒅

𝑬 ∙ 𝒅𝑺+ ׯ𝒄𝒖𝒓𝒗𝒆𝒅 𝒔𝒖𝒓𝒇𝒂𝒄𝒆
𝑬 ∙ 𝒅𝑺

∅E =  0+ ׯ𝒓𝒊𝒈𝒉𝒕 𝒆𝒏𝒅
𝑬. 𝒅𝑺+ 0 = E S

E S = 
𝜎 S

ε0

Gauss’s law

∅E = ර E ∙ dS =
qenclosed

ε0
 =

𝜎 S

ε0

E = 
𝜎 

ε0

Cylindrical  
Gaussian surface

Right end

Curved surface

Left end

E is independent on r

❖ Infinitely conducting 

sheet of charge

E = 
𝜎 

2ε0

❖ Infinitely non conducting 

sheet of charge



Electric field due to a uniformly charged sphere 

Volume charge distribution 𝜌 =
𝑞

𝑉

Spherical Gaussian surface with radius r 

∅E ׯ = 𝐸 ∙ 𝑑𝑆

𝐸 ර 𝑑𝑆 = 𝐸 4𝜋𝑟2  

𝐸 4𝜋𝑟2  = 
q

ε0

Gauss’s law ∅E = ׯ E ∙ dS =
q

ε0
 

E = 
𝟏

𝟒𝝅𝜺𝟎
 ×

𝒒

𝒓𝟐

(i) At a point outside the charged sphere: (r >R)

O+ q

R

P

r

A

Gaussian surface

(ii) At a point on the Surface: (r = R)

Charged 
sphere

O + q

R = 

P

r

A

Gaussian surface
E = 

𝟏

𝟒𝝅𝜺𝟎
 ×

𝒒

𝑹𝟐



Electric field due to a uniformly charged sphere 

Volume charge distribution 𝜌 =
𝑞

𝑉
 = 

𝑞

 
4

3
𝜋𝑅3

Spherical Gaussian surface with radius 𝑟′ 

Gauss’s law ∅E = ׯ E ∙ dS =
𝑞′

ε0
 

E = 
𝟏

𝟒𝝅𝜺𝟎
 ×

𝒒𝑟′

𝑹𝟑

(iii) At a point inside the charged sphere: (𝒓′ < R)

O
+ q ’

R

P ’  

r ’

A ’ 

Gaussian surface

A 

+ q 

E
dS

Charged 
sphereTotal charge enclosed by Gaussian surface 

𝑞′  = 𝜌𝑉′ = 𝑞

 4
3

𝜋𝑅3
4𝜋𝑟′3 = q

𝑟′

 𝑅

3

∅E ׯ = 𝐸 ∙ 𝑑𝑆 =  𝐸 4𝜋𝑟′2

𝐸 4𝜋𝑟′2
 =

𝑞′

ε0

𝐸 4𝜋𝑟′2
=q

𝑟′

 𝑅

3



Charged sphere

Inside sphere On  sphere Outside sphere

𝑬 =
𝟏

𝟒𝝅𝜺𝟎
 𝑿

𝒒𝒓

𝑹𝟑

𝑬 =
𝟏

𝟒𝝅𝜺𝟎
 𝑿

𝒒

𝑹𝟐

𝑬 =
𝟏

𝟒𝝅𝜺𝟎
 𝑿

𝒒

𝒓𝟐

r < R r = R r > R

𝑬 𝜶
𝟏

𝒓𝟐𝑬 𝜶 𝒓

Electric field due to a uniformly charged sphere 



Charged cylinder

Inside cylinder Outside cylinder

𝑬 =
𝝀

𝟐𝝅𝝐𝝄 𝒓𝑬 =
𝝀 𝒓

𝟐𝝅𝝐𝝄 𝑹𝟐

Electric field due to a uniformly charged cylinder 

𝑬 𝜶
𝟏

𝒓
𝑬 𝜶 𝒓



1) An infinite line charge produces a field of 9x104 N/C at a distance of 2 cm. Find the 

linear charge density.

Topic: Electric flux and Application of Gauss’s law

Worked out Examples-III

Solution:   E = 9x104 N/C , r = 2 cm

    Formula : E = 
𝜆

2𝜋𝜀0𝑟

    𝜆 = 
4𝜋𝜀0𝐸𝑟

2
 = 

9X104x0.02

9x109x 2
 = 0.1 μC/m

Solution: q = 4x10-8 C , R = 1 cm, r = 2cm         

  r > R (Outside the charged sphere )

   Formula : E = 
𝑞

4𝜋𝜀0𝑟2 

   E = 
9x109x4x10−8

4x10−4  =  9x105 N/C

2) A charge of 4x10-8 C is distributed uniformly on the surface of a sphere of radius 1 cm. 

It is covered by a concentric, hollow conducting sphere of radius 5 cm. Find the electric 

field at a point 2 cm away from the centre.



Topic: Electric flux and Application of Gauss’s law

1) Electric intensity at a point varies as r -1 for            [ ]

(a) a point charge     (b) spherically symmetric charge distribution

(c) a plane sheet of charge   (d) a line charge of infinite length

2) Eight dipoles of charges of magnitude ‘q’ are placed inside a cube. The total electric flux through the 

cube will be                    [ ]

     (a) 
8𝑞

𝜀0
    (b)

16𝑞

𝜀0
     (c) 

𝑞

𝜀0
     (d) Zero

3) A uniform electric field is given by E = 3X103 Ƹi N/C  . What is the flux of this field through a square 

of 10 cm on a side whose plane is parallel to YZ plane?          [ ]

     (a) 30 2 Nm2/C  (b)   30 Nm2/C   (c) 
30

2
Nm2/C   (d) Zero

4) Choose the correct graphical representation for Electric field due to a charge sphere (E vs r) [ ]

  

Assignment-III

Answers: (1Q : d),   (2Q:  d) , (3Q: b), (4Q: d)



❑  Work done to move a charge from one point to another point in electric   

      field is independent of path

❑  Work done depends only on the initial and final positions of the charge.

❑  Line integral of the electric field along a closed path is zero. 

❑  Conservative electric field is irrotational as the curl of electric field is zero.

Conservative nature of electric field E, irrotational field 

ර 𝐄 ∙ 𝐝𝐥 =  𝛁 𝐗 𝐄 = 𝟎

❖  Prove that E = 2x i +2y j +3 z k is an electrostatic field.

❖  A field vector has following components:        

      It is possible that E be an electrostatic field? 

2 2E 3 ,E - y  and E 2 .x y zxy x x= = =

Electrostatic fields are conservative fields



Electric potential, the amount of work needed to move a unit charge 

from a reference point to a specific point against an electric field. 

ELECTRIC POTENTIAL 

Electric potential due to point charge  V  =   
𝒒

𝟒𝝅𝜀0𝑟

Potential difference between the points A and B in the electric field is 𝑉𝐴  −  𝑉𝐵 =
𝑊

𝑞

Electric potential at a point  V = 
𝑊

𝑞
     

Units: J/C or Volt (V), e.m.f. It is a scalar quantity
V =Ed

Relation between electric field and potential:

Negative gradient of electric potential is equal to  Electric field.

V= − ׬ 𝐄 ∙ 𝐝𝐥

E = - grad V = -𝛁 𝐕

Electric Potential due to multiple charges:

V = V1 + V2 + ………. + Vn (Algebraic sum) 



▪ The locus of all points which have the same electric 

potential is called equipotential surface.

▪ VA  −  VB =
W

q
 = 0

▪ Work done is zero.

▪ The lines of force at every point of the equipotential 

surface are perpendicular to the surface.

▪ Example : Surface of a conductor

Plane equipotential surface

Spherical equipotential surface

Equipotential surfaces

V  =   
𝑞

4𝜋𝜀0𝑟
 , E  =   

𝑞

4𝜋𝜀0𝑟2

VA =  VB

EA ≠ ഥEB r4

4 surface

r4

Electric field is vector , Electric potential is scalar 



1) A work of 45x10-7J is being done to move a charge between two points of potential 

difference 360 V. The charge is                  [ ]

     (a) 12.5 nC   (b) 8 nC   (c) 25 nC   (d) 16 nC 

Topic: Irrotational Electric field and Electric Potential

Worked out Examples-IV

Solution:   W = 45x10-7 J , ∆ V = 360 V

     Formula : ∆V = 
𝑊

𝑞

     𝑞 = 
𝑊

∆V
 = 

45X10−7x0.02

360
 = 12.5 nC

3 m3 3 m

2) The potential due to a charge 10 μC  at certain distance(x) is 3x104 V. The value 

     of ‘x’ is                   [ ] 

(a)     (b)     (c) 3 m    (d) 6 m 

Solution:  q = 10 μC= 6x10-6 C , V= 3x104 V

    Formula : V = 
𝑞

4𝜋𝜀0𝑟
 

     r = 
𝑞

4𝜋𝜀0𝑉
 = 

9x109x10x10−6

3x104
 = 3 m



Topic: Irrotational Electric field and Electric Potential

1) Choose correct unit for electric field.             [ ]

(a)N/C , V/m   (b) N/m, V/C   (c) Nm, VC   (d) J/C, J/m

2) Which of the following is not true for static electric field.        [ ]

(a) Irrotational field           (b) Conservative field

(c) Negative gradient of electric potential is electric field  (d) Scalar quantity

3) The electric potential at a point which is at a distance of 1m from a charge of 10 µC is [ ]

(a)105 V    (b) 9x10-4 V   (c) 9x104 V   (d) 106 V

4) Select the correct choice after reading the two statements given below.    [ ] 

Statement-I: The electric field is always tangential to the surface of a conductor

Statement-II: The potential at every point on the surface of a conductor is the same.

(a) Statement-I is correct, Statement-II is wrong  

(b) Statement-I is wrong, Statement-II is correct

(c) Both statements are correct      (d) Both statements are wrong 

Assignment-IV

Answers: (1Q : a),   (2Q:  d) , (3Q: c), (4Q: c) 



Topic: Irrotational Electric field and Electric Potential

Assignment-IV

Answers: (5Q : d),   (6Q:  c) , (7Q: a), (8Q: a)

5) The electric potential V (in volt) varies with distance x (in meter) according to the relation  

V = 5 + 4x2. The force experienced by a negative charge of 2x10-6 C located at x = 0.5 m is

(a) 2x10-6 N    (b) 4x10-6 N  (c) 6x10-6 N   (d) 8x10-6 N    [ ]

6) A charge of 6 μC in an electric field is acted on by a force 3 N. The potential gradient at that 

point is                 [ ]

 (a) 105 V/m    (b) 2x10-6 V/m  (c) 5x105 V/m  (d) 18x10-6 V/m

7) The potential at the origin is zero due to electric field                                    .                            

The potential at point P (2m, 2m) is              [ ]

(a) - 100 V    (b) 25 V    (c) 50 V  (d) 

8) The electric field due to a point charge is 360 N/C. The electric potential at that point is              

18 J/C. The magnitude of the charge in nano- coulomb is         [ ]

       (a) 0.1    (b) 0.4   (c) 10   (d) 40

^ ^

E = 20 i  + 30 j N/C

 50 2 V−



U (r) = 
1

4𝜋𝜀0
 [  

𝑞1𝑞2

𝑟12
  + 

𝑞2𝑞3

𝑟23
 +

𝑞1𝑞3

𝑟13
]

Potential energy of system of charges

Energy density in electrostatic field:

Energy density = 
energy stored
unit volume 

Electrostatic energy :           U =
𝟏

𝟐
 qV

U (r) = 
q1 

q2

4𝜋𝜀0 𝑟

u = 
𝟏

𝟐
 𝜺𝟎𝑬𝟐

Electric potential energy is the energy 

that is needed to move a charge against 

an electric field.



Spherical charge 
distribution

Outside sphereOn the sphereInside the sphere

V =
𝟏

𝟒𝛑𝛆𝟎
 𝐗

𝐪

𝐫
V =

𝟏

𝟒𝛑𝛆𝟎
 𝐗

𝐪

𝐑
V =

𝟏

𝟒𝛑𝛆𝟎
 𝐗

𝐪

𝐑

+

P
r

R

O
+

q

+
+

++

+ +

+

+

P
r

R

O

+

+

q

+
+

++

+ +

+

++

P
r

R

O

+

+

q

+
+

++

+ +

+

Potential due to a spherical  charge distribution

𝐄 =
𝟏

𝟒𝛑𝛆𝟎
 𝐗

𝐪𝐫

𝐑𝟑
𝐄 =

𝟏

𝟒𝛑𝛆𝟎
 𝐗

𝐪

𝐑𝟐 𝐄 =
𝟏

𝟒𝛑𝛆𝟎
 𝐗

𝐪

𝐫𝟐



S
p

h
er

ic
a

l 
co

n
d

u
ct

o
r Outside the 

surface

lies on the 
surface

Inside the 
surface

V =
𝟏

𝟒𝝅𝜺𝟎
 𝑿

𝒒

𝒓
 

𝑬 =
𝟏

𝟒𝝅𝜺𝟎
 𝑿

𝒒

𝒓𝟐

V =
𝟏

𝟒𝝅𝜺𝟎
 𝑿

𝒒

𝑹
  

𝑬 =
𝟏

𝟒𝝅𝜺𝟎
 𝑿

𝒒

𝑹𝟐 

V =
𝟏

𝟒𝝅𝜺𝟎
 𝑿

𝒒

𝑹

E = 0

O
R

Potential due to a charged spherical  conductor

Properties of Conductors 

❖  The electric field is zero everywhere inside the conductor

❖  Any net charge resides on the conductor’s surface

❖  Electric field just outside charged conductor is perpendicular to conductor’s surface.



• Dipole placed in Uniform electric field

• Total force acting on the dipole is zero

• Total torque on the dipole is not zero

• Torque tends to rotate the dipole

Electric dipole: Any two  point charges which are equal in 

magnitude but have opposite signs and are separated by a small 

distance are said to be “electric dipole”.

Electric dipole moment     p = q d         Units: coulomb-meter 

Vector quantity  (Direction is from negative to positive) 

Torque acting on an Electric Dipole placed in uniform electric field

Electric potential energy  ∆𝑈 = −𝑝. 𝐸 = −𝑝𝐸𝑐𝑜𝑠𝜃
𝜃 = 00  → ∆𝑈𝑚𝑖𝑛= −𝑝𝐸, 𝜃 = 900  → ∆𝑈 = 0,
𝜃 = 1800  → ∆𝑈𝑚𝑎𝑥= + 𝑝𝐸 

+

+

+

+

-

-

-

-

E

Torque 𝜏 = 𝑝𝑋𝐸 = 𝑝𝐸𝑠𝑖𝑛𝜃 ො𝑛
𝜃 = 00 → 𝜏 = 0 , 𝜃 = 900  → 𝜏𝑚𝑎𝑥 = 𝑝𝐸 

Torque



1) Two charges 4 μC and 7 C are placed 4.5 m apart. Find mutual potential energy of the 

      system.              

Topic: Electric potential , Potential energy and Torque on Electric dipole

Worked out Examples-V

Solution: q = 3 μC= 3x10-6 C , d = 5mm = 5x10-3 m, E= 2x106 V/m

Formula : 𝜏 = 𝑝𝑋𝐸 , p = qd

   𝜏 = 𝑞𝑑 𝑋 𝐸𝑠𝑖𝑛𝜃 = 3x10-6 x 5x10-3 x 2x106 𝑠𝑖𝑛900 

    𝜏 = 0.03 N.m

2) Two charged +3 µC and -3 µC are situated at a distance 5 mm in a uniform electric field 

2x106 V/m, angle between dipole and electric field is 900. Find torque produced on the system.

Solution:  q1 = 4 μC , q2 = 7 μC , r = 4.5

Formula :  U = 
q1 

q2

4𝜋𝜀0 𝑟
 = 

9𝑋109 (4𝑋10−6)(7𝑋10−6)

4.5
 

              U = 5.6 X 104 N



Topic: Electric potential , Potential energy and Torque on Electric dipole

Assignment-V

Answers: (1Q : b),   (2Q:  d) , (3Q: d)

1) An electric dipole placed with its axis inclined at an angle to the direction of a uniform 

electric field experiences                [ ]

     (a) A force but no torque     (b) a torque but no force 

     (c) a fore as well as a torque    (d) neither force nor a torque 

2) Choose the correct graphical representation for potential due to a charge conducting sphere 

(a)      (b)      (c)     (d)      [ ] 

3) Electric field inside a charged hollow sphere is          [ ]

    (a) uniform  (b) maximum at center (c) maximum inside the surface    (d) zero



APPLICATIONS

➢ Van de Graaff generator, 

➢ Photocopiers, Laser printers, Ink-jet printers

➢ Smoke Precipitators and Electrostatic Air Cleaning.

Electrostatics is the study of electric fields in static equilibrium. 

REFERENCE BOOKS

▪ Fundamentals of Physics: Halliday/Resnick/Walker Wiley India Edition 2007

▪ Introduction to Electrodynamics by David J. Griffith

▪ Electromagnetic theory and electro dynamics by Sathya Prakash
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▪ Engineering Physics by R.K Gaur and S.L Gupta

▪ University Physics by Young and Freeman, Pearson Education

▪ Unified  Physics Electromagnetism by Dr. S.L Gupta, Sanjeev Gupta
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SUMMARY

▪ Electric charges: Positive, Negative , charge of one electron = 1.6 X 10-19 C

▪ Unlike charges attracted and like charged repeal with each other

▪ Coulomb's law: F = 
𝒌 𝒒𝟏𝒒𝟐

𝒓𝟐

▪ Electric field strength  E = 
𝑭

𝒒

▪ Tangent drawn at any point on electric field line gives direction of electric field at that 

point. 

▪ Electric flux:  ∅𝐸 = ׯ 𝑬 ∙ 𝑑𝑺 =  E S cos 𝜃

▪ Gauss’s law (Maxwell’s first equation): ∅𝐄 = ׯ 𝐄 ∙ 𝐝𝐒 =
𝐪𝐞𝐧𝐜𝐥𝐨𝐬𝐞𝐝

𝛆𝟎
 , 𝜵. 𝑬 =

𝝆

𝜺𝟎
,  𝜵. 𝑫 = 𝝆 

▪ Applications of Gauss’s law: Electric field due to different charge distributions

▪ Conservative nature of electrostatic field, irrotational field ׯ E ∙ dl =  ∇ X E = 0

▪ Electric potential: V = 
𝑊

𝑞
, V= Ed

▪ Relation between electric field and electric potential:

▪ Potential energy of  system of charges  U (r) = 
𝟏

𝟒𝝅𝜺𝟎
 [ 

𝒒𝟏𝒒𝟐

𝒓𝟏𝟐
  + 

𝒒𝟐𝒒𝟑

𝒓𝟐𝟑
 +

𝒒𝟏𝒒𝟑

𝒓𝟏𝟑
 ]

▪ Torque acting on electric dipole placed in uniform E, p = q d,, 𝝉 = 𝒑𝑿𝑬, ∆𝑼 = −𝒑. 𝑬

V= − ׬ 𝐄 ∙ 𝐝𝐥,  E = - grad V = -𝛁 𝐕



SUMMARY (Important formulas)

❖ Electric field due to an infinitely long charge distribution:  E = 
λ

2πε0r
 

❖ Electric field due to an infinitely conducting sheet of charge: E = 
σ 

ε0

❖ Electric field due to an infinitely non conducting sheet of charge: E = 
σ 

2ε0

❖ Electric field due to a uniformly charged cylinder:

     Inside sphere:E =
λ r

2πϵο R2, Out side Sphere:  E =
λ

2πϵο r

❖ Electric field due to a spherical charge distribution: 

     Inside sphere: 𝐄 =
𝟏

𝟒𝛑𝛆𝟎
 𝐗

𝐪𝐫

𝐑𝟑, On sphere: E =
1

4πε0
 X

q

R2, Out side Sphere: E =
1

4πε0
 X

q

r2

❖ Electric potential due to a spherical charge distribution :

     Inside sphere: V =
1

4πε0
 X

q

R
, On sphere: V =

1

4πε0
 X

q

R
, Out side Sphere: V =

1

4πε0
 X

q

r

❖ Electric field due to a charged spherical  conductor:

     Inside sphere: 𝐄 = 𝟎, On sphere: E =
1

4πε0
 X

q

R2, Out side Sphere: E =
1

4πε0
 X

q

r2

❖ Potential due to a charged spherical conductor:

     Inside sphere:V =
1

4πε0
 X

q

R
, On sphere:V =

1

4πε0
 X

q

R
, Out side Sphere:V =

1

4πε0
 X

q

r



CPGET – Previous year questions

1) Electric field at a point inside a uniformly charged sphere is     (CPGET -2020)

(a) Zero    (b) 
𝑞

4πε0𝑎3    (c) 
𝑞𝑟

4πε0
   (d) 

𝑞𝑟

4πε0𝑎3 

2) Q1 and Q2 Coulomb and r =1 m, ( 
1

4πε0
= 9x109) then the force between the charges is

(a) 18x109 N  (b) 9x109 N   (c) 0.9x109 N  (d) 10x109 N   (CPGET -2020)

3) A spherical drop of water carrying a charge of 3x10-6 C has a potential of 500 Volts at its surface. 

What is the radius of the drop?             (CPGET -2020)

(a) 54 m   (b) 64 m   (c) 540 m   (d) 640 m

4) The electric field strength at a distance ‘r’ due to infinite line of charge density 𝜆 is   

(a) (
1

4πε0
)(

2𝜆

𝑟
)  (b) (

1

4πε0
)(

𝜆

𝑟
)  (c) (

1

4πε0
)(

𝜆

2𝑟
)  (d) (

1

4πε0
)(

4𝜆

𝑟
)  (CPGET -2018)

Answers: (1Q : d),   (2Q:  b) , (3Q: c), (4Q: a)



CPGET – Previous year questions

5) How many electrons are there in one coulomb of charge?        (CET-2017)

  (a) 6.023x1023  (b) 6.023x1020  (c) 6.023x1018  (d) 6.023x1015    

6) The Gauss law for electric fields in a homogenous medium in absence of charges is   (CET-2017)

(a) ∇. E =
ρ

ε0
  (b) ∇. D = ρ  (c) ∇. E = 0  (d) ∇2E =

ρ

ε0
 

7) Which of the following is a vector quantity?           (CET-2017)

(a) Electric charge (b) Electric potential (c) Electric field  (d) Electric flux

8) A region is specified by the potential V = 5x +4y – 10 z then the electric field is (i, j, k are unit vectors)

(a) 5i +4j +10k (b) 5i-4j+10k  (c) -5i-4j-10k  (d) -5i-4j+10k

9) The Maxwell’s equation ׯ E ∙ dS =
𝑞

ε0
 is            (CET-2015)

(a) Gauss law of electricity    (b) Faraday’s law

(c) Gauss law of magnetism    (d) Ampere’s law

Answers: (5Q : c),   (6Q:  c) , (7Q: c), (8Q : d), (9Q: a)



IIT JAM – Previous year questions

1) In terms of the basic units of mass (M), length (L) time (T) and charge (Q), the dimensions of 

electric permittivity of  vacuum (ε0) are          (JAM -2007)

     (a) M-1L-3T2Q2  (b) ML2T-1Q-2   (c) LTQ-1  (d) LT-1Q-1

2) A hollow thin spherical shell of radius R is given a charge Q. The electric field at a point x               

(0 < x <R) is                 (JAM – 2005) 

    (a) 
𝑄

4πε0𝑅2    (b) 
𝑄

4πε0𝑥2    (c) 
𝑄

4πε0𝑥
  (d) zero  

3) An electric field in a region is given by ത𝐸 𝑥, 𝑦, 𝑧 = 𝑎𝑥 Ƹ𝑖 + 𝑐𝑧 ෡𝑗 +6𝑏𝑦 ෠𝑘. For which values of a, 

b and c does this represent an electrostatic field?          (JEST -2021)

(a) 13, 1, 12  (b) 17, 6, 1   (c) 13, 1 ,6  (d) 45, 6, 1

4) Equipotential surfaces corresponding to a particular charge distribution are given by                                

4𝑥2 + (𝑦 − 2)2 + 𝑧2 = 𝑉𝑖  where the values of Vi are constants. The electric field 𝐸 at the origin is

(a) 𝐸 = 0  (b) 𝐸 = 2 ො𝑥   (c) 𝐸 = 2 ො𝑦  (d) 𝐸 = −4 ො𝑦    (JAM -2011)

Answers: (1Q : c),   (2Q:  b) , (3Q : d), (4Q : d)



IIT JAM – Previous year questions

5) Two-point charges +q1 and q2 are fixed with a finite distance d between them. It is desired to put a third 

charge q3 in between these two charges on line joining them so that the charge q3 is in equilibrium. This is

(a) possible only if q3 is positive      (b) possible only if q3 is negative  (JAM -2005)

(c) possible irrespective of the sign of q3     (d) not possible at all

6) If the electrostatic potential at point (x,y) is given by V = (2x+ 4y) volts, electrostatic energy density at that 

point (J/m3) is                  (JAM -2008)

(a) 5ε0     (b) 10 ε0    (c) 20 ε0   (d) 
1

2 
ε0(2𝑥 + 4𝑦)2

7) If  𝐸1 = 𝑥𝑦 Ƹ𝑖 + 2𝑦𝑧 Ƹ𝑗 + 3𝑥𝑧 ෠𝑘 and 𝐸2 = 𝑦2 Ƹ𝑖 + (2𝑥𝑦 + 𝑧2) Ƹ𝑗 + 2𝑦𝑧 ෠𝑘     (JAM-2013)

(a Both are impossible electrostatic fields.  (b) Both are possible electrostatic fields

(c) Only 𝐸1 is a possible electrostatic field  (d) Only 𝐸2 is a possible electrostatic field

8) A small charged spherical shell of radius 0.01 m at a potential of 30 V. The electrostatic energy of the shell 

is                     (JAM 2014) 

(A) 10-10 J   (B) 5 x 10-10 J  (C) 5 x 10-9 J  (D) 10-9 J 

Answers: (5Q : c),   (6Q:  b) , (7Q : d), (8Q: b)
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Objectives
➢ Introduction to Electrostatics

➢ Examples on Electrostatics

➢ Basic properties of Electric charges

➢ Electric field

➢ Concept of electric field lines and electric flux

➢ Gauss’s law (Integral and differential forms)

➢ Application to linear, plane and spherical charge distributions.

➢ Conservative nature of electric field E, irrotational field. 

➢ Electric Potential-Concept of electric potential

➢ Relation between electric potential and electric field

➢ Potential energy of a system of charges. 

➢ Energy density in an electric field.

➢ Calculation of potential from electric field for a spherical charge distribution.

➢ Applications of Electrostatics



Pre Test
1) What is electrostatics physics?

2) What are the two types of electrostatic forces?

3) Mention the properties of Electrostatic field lines.

4) What does Coulomb's law state?

5) What are the applications of Electrostatics?

6) How Electric field is calculated for different shapes?



Multiple choice questions

1) If the electric field is uniform. Then         [     ]

    (a) Its magnitude is same but direction is not same       (b) Its magnitude is not same but direction is same

    (c) Its magnitude and direction remains same       (d) Its magnitude and direction are not same

  

2) A proton and an electron are place in a uniform electric field       [     ]

    (a) Their acceleration will be equal        (b) The magnitudes of their acceleration will be equal

    (c) The electric force acing on them will be equal       (d) The magnitude of forces will be equal 

3) Find the force experienced by a chloride ion having 2 electrons removed, when placed in an  electric field of intensity 5 N/C. [     ]     

    (a) 1.6x10-18 N  (b) 3.2x10-18 N  (c) 12.8x10-19 N  (d) 8 N

4) The energy density in the electric field created by a point charge falls off with the distance from the point charge as   [  ]

    (a) 1/r   (b) 1/r2   (c) 1/r3   (d) 1/r4

   

5) A charge of 6 μC in an electric field is acted on by a force 3 N. The potential gradient at that point is    [     ]

    (a) 105 V/m                   (b) 2x10-6 V/m  (c) 5x105 V/m  (d) 18x10-6 V/m



Introduction

Electrostatics is a branch of physics, which deals with the phenomena and 

properties of stationary or slow-moving electric charges.

Electrostatics is the study of forces between charges, as described by 

Coulomb's Law.



Everyday life examples of electrostatics

➢Thunder and Lighting. 

➢  Rubbing balloons on hair and sticking to the wall 

➢The attraction of paper to a charged scale. 

➢The damage of electronic components during manufacturing 

➢  Photocopier & laser printer operation 

➢  When we comb our hair on a dry day and bring the comb close 

to tiny pieces of paper, we note that they are swiftly attracted 

by the comb. This is due to Electrostatic phenomena. 



Electric charge
Every substance is made up of atoms.

Atom consists of protons, neutrons, electrons.

Charge is a scalar quantity.

Units: Coulomb , C 

Dimensional formula : [AT]

Protons = +ve charge

Electron = -ve charge

Neutron = 0 charge

Mass Charge

Proton 1.673 X 10-27 kg + 1.6 X 10-19 C

Neutron 1.675 X 10-27 kg 0

Electron 9.1 X 10-31 kg - 1.6 X 10-19 C



Charge is a physical property of a matter that experiences a force when placed 

in electromagnetic field.

Charges

Positive Negative 

Unlike charges Attracts each other

Like charges repel Like charges repel

+-

+ + - -

❖ Unlike charges are attract with each other.

There is attract force between Positive and Negative charges.

❖ Like charges are repeal with each other. 

There is repulsive force between two positive charged and negative charges.



Properties of charge

Charge quantization:

 Charge on any substance can be written as integral multiple of a certain 

minimum electric charge. 

            Q = +/- ne    (n is integer) 

Charge is conserved:

 Electric charge can neither be created nor be destroyed but can be 

transferred from one material to the other. 

Additivity of charges: 

The total charge of a body is the algebraic sum of all the charges on the 

body. Charge is a scalar quantity.



Topic: Electric charge

1) What is the charge of Lithium Nucleus?

Solution:

Li atomic number = 3

Number of Protons n = 3

Charge of Proton e= 1.6x10-19 C

Q = ne

Q = 3x 1.6 x10-19 = 4.8x10-19 C

Worked out Examples-I



Assignment -I

Topic: Electric Charge

1. What is the charge of Gold Nucleus?

2.  How many number of electrons added to isolated conductor to get charge on its surface is 

3.612x10-19 C.

3. What is the charge of Nucleus with atomic number 4?

4.      When 1020 electrons are removed from the neutral material, then the electric    

         charge present on it will be ( Charge of electron = 1.6 x10-19 C)   [ ]

         (a) - 16 C  (b) + 16 C  (c)  - 1.6 C  (d)  + 1.6 C 



THANK YOU
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➢  Basics of Electrostatics

➢  Basics of Magnetostatics

➢  Faraday’s law

➢  Ampere’s law

➢  Fleming’s left hand rule

➢  Force between two parallel current carrying conductors

➢  Application of Electromagnetic Induction (Maglev trains)

➢  History of maglev trains 

➢  Maglev trains theory and technology

➢  Working principle of maglev trains

➢ Comparison between conventional trains & maglev trains 

➢ Scope of research

➢  Summery

OBJECTIVES
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Basics of Electrostatics

Unlike charges attract with each other

Unlike charges Attracts each other-+

Like charges repel Like charges repel- - + +

Like charges repel with each other

How  do 

charge 

behaves?
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Basics of Magnetostatics

Like poles repel

Unlike poles attracts

❖   Magnet contains North and South poles

❖   Individual poles does not exist 
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Important laws in EM theory

Faraday’s law: 

Current induced in a coil 

when it is exposed to a 

changing magnetic field.

Right hand thumb rule

Ampere’s law: 

Magnetic field exist 

in current flowing in 

a conductor.

Fleming ‘s left hand rule

Force on a current 

caring conductor
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Force between two parallel current 

carrying conductors

Current

Rail

Magnetic 

field

Parallel conductors 

carrying current in opposite 

direction repel each other
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Application of Electromagnetic induction 

(Maglev trains)
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MODE OF TRANSPORTATION
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Energy source

CONVENTIONAL MODE OF TRANSPORT

MAGLEV TRAINS 

Fast, comfortable, 

pollution free,                     

energy efficient, 

weather proof

SOLUTION
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Eric Roberts Laithwaite 
British Electrical Engineer

FATHER OF MAGLEV

HISTORY OF MAGLEV TRAINS
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Maglev = Magnetic + Levitation

MAGLEV TRAINS THEORY

Buoyant levitation Aerodynamic levitation Aerodynamic levitation
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It has two sets of Magnets

 2) To move elevated train ahead1) To repel and push train up off track 

MAGLEV TRAINS THEORY

Initial thought towards Maglev trains:
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Maglev train functions:

➢ Levitation

➢ Propulsion

➢ Lateral guidance

                         

                        

BASIC PRINCIPLE OF MAGLEV TRAINS
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1) ELECTRODYNAMIC SUSPENSION (EDS)

2) ELECTROMAGNETIC SUSPENSION (EMS)

ELECTRODYNAMIC SUSPENSION:

 

Super conductors: 
➢ Zero resistance

➢ Perfect diamagnet

➢ Exhibit Meissner Effect

LEVITATION

Magnetic levitation with super conductor
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➢  Electromagnet coils placed on guide  

    walls.

➢  Alternating current passes through  

    electromagnet coils.

➢  It creates a magnetic field that attracts 

and repeals the superconducting 

magnets.

➢As a result train moves in forward 

direction.

Current

Electromagnetic coils

Electromagnetic coilsGuide way

Superconducting 

magnets

PROPULSION
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When one side of train nears the side 

of the guideway

Super conducting magnet on the train 

induces two forces

➢Repulsive force from the levitation 

coils on the side closer to the train.

➢Attractive force from the coils on the 

farther side.

LATERAL GUIDANCE

This keeps the train in the centre
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ELECTRODYNAMIC SUSPENSION (EDS)

➢Current is induced due to passing of 

superconducting magnets through 

levitation coils.

➢ Induced current creates magnetic filed.

➢Force in track is created by induced 

magnetic field in coils.

➢Train pushed in upward direction by 

magnetic force and Levitate 10 cm 

above the track.
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FEATURE CONVENTIONAL TRAIN MAGLEV TRAIN 

SPEED Limited speed High Speed

MAINTENANCE High maintenance Low maintenance

ALL WEATHER 

OPERATION

Effected by weather 

conditions.

Unaffected by snow, severe cold, 

rain or high winds. 

EFFICIENCY It affected by rolling 

resistance due to contact 

with track.

No rolling resistance due to lack of 

contact between track & vehicle.

           High power efficiency 

Comparison between Conventional trains & Maglev trains
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SCOPE OF RESEARCH 
HYPERLOOP TRAINS MAGLEV TRAINS

HYPERLOOP TRAINS: Vactrains

Hyperloop train is Maglev train placed in vacuum tube to 

eliminate air drag force.
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THANK YOU
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Syllabus



UNIT- I
Understanding Of Computer And 

Word Processing 



Introduction: The term computer is derived from 

the Latin word compute, which means to calculate. 

A computer is a tool and partner in every sphere of 

human life and activity. Computers are bringing 

many changes in industry, government, education, 

medicine, scientific research, law, social service.

Knowing about computer

Definition: A Computer is an electronic device 

that processes data and converts it into information 

that is useful to people

What is computer?



The basic components of a computer 

can be classified into four main units: 

1. Input Unit. 

2. Central Processing Unit 

3. Memory Unit

4. Output Unit 

Basic components of a computer system



The devices that are used to enter data 

and instructions into the computer are 

known as Input devices. 

It includes Keyboard, Mouse, 

touchscreens, 

Joysticks, 

barcode readers, 

scanners

Input Devices 



Input Devices  (Keyboard)
A keyboard is the primary input 

device. 

It can be used to enter the text input. 

A standard keyboard contains about 

100 keys. 

It contains Typing keys, numeric 

keypad, Control keys, function keys, 

cursor keys and special purpose keys. 

The computer keyboard uses the 

QWERTY key arrangement.



A Mouse is a graphical input device. 

You can move the mouse around a surface and 

controls the pointer. 

By using the mouse, you can perform: 

1. Clicking 

II. Double-Clicking 

III. Dragging 

IV. Right Clicking

Input devices (Mouse)

There are two types of Mouse’s: 

1. Physical Mouse 

2. Optical Mouse

Physical Mouse Optical Mouse



Touch Screen: A touch screen is a type 

of screen that allows you to input by 

touching its icons. 

Joystick: A Joystick is a game controller. 

It is a swivelling lever. It is well suited for 

playing video games. 

Scanner: A scanner is an input device. It 

can scan a document or an image into the 

computer's memory. 

Input devices 



Microphone: A Microphone enables 

you to input your voice or music as 

data. Microphones are useful for audio 

and video conferencing. 

Barcode readers Barcode readers 

are one of the most widely used input 

devices. They can read the bar codes 

on the products. 

Input devices 



he devices that can display the resulting 

information to the user are known as 

Output devices. 

❖ Monitors 

❖ Printers

❖ Speaker

❖ Headphone

❖ Projector

Monitors and Printers are commonly used output 

devices

Output Devices 



Monitor is a commonly used output device. 

It is also called as Visual Display Unit(VDU). 

It provides a visual display of data.

Monitors are of different types: 

1. CRT( Cathode Ray Tubes) 

2. LCD(Liquid Crystal Display) 

3. LED(Light Emitting Diode) 

Output Devices (Monitor) 

LCD

CRT

LED



A Printer is an output device that prints text or 

images on paper. 

Printers are useful to create ‘hard copy’ of data. 

Printers are of two types: 

1. Impact printers 

2. Non-impact printers.

Output Devices (Printer) 

Impact printer

Impact printers: Impact printers can print by striking 

the paper. Example: Line printers, dot-matrix printers.

Non-impact printers: Non-impact printers do not 

strike the paper. Example: laser printers, inkjet printers. 

Non -impact printer



1. Impact Printers: Impact printers these Printers use 

an Electro-mechanical mechanism. An impact printer 

refers to all those printers whose printing heads touch 

the paper. His mechanism uses hammers or pins to 

strike against a ribbon and paper to print the text or 

image.

2. Non -Impact Printers:  These printer uses ink and 

special electrical machines for producing outputs. Non 

– impact printers are all those printers whose printing 

heads do not touch paper. A non impact printer forms 

characters and image on a piece of paper without 

actually striking the paper.

Differences Between Impact and Non-Impact Printers



S. N. Features Impact printers Non-Impact printers

1 Mechanism It produces print on paper by striking mechanism.
It produces print on paper with a non-striking mechanism . 

it uses Electro static or thermal mechanism.

2 Working
It uses pins, hammers or wheel to strike against an inked

ribbon to print on a paper.

It uses laser, spray of special ink, or heat and pressure to

print on paper.

3 Color output impact printers has no color capacity
Non-Impact printers can print clear color, good for printing 

pictures

4 Cost Impact printers are normally less expansive. Non-Impact printers are more expansive.

5 Graphics Image
Except of dot matrix printer, these printers can not print 

graphics images
These printer can easily print graphical images

6 Tools
Impact printers use special inked ribbons to produce print

on paper when print head strikes.

Non-Impact printers use toner or cartridge for printing on

paper.

7 Speed Impact printers are low speed printers.

Non-Impact printers are very fast. They can print many 

pages

per minute.

8
Sound effects or 

Noise

Impact printers are high noise level because they strike 

print head.

Non-Impact printers do not make a noise level because 

they do not use striking mechanism in which print head 

strikes on ribbon and paper etc.

9 Character style
The character style can not be changed in the impact 

printer (except of dot matrix)

It can print different types of characters form busing the 

individual printer

10 Copy print Impact printers can produce multiple copies of the text.
Non impact printers can produce only a single copy of the 

text

11 Technology Impact printers use old printing technologies. Non impact printers use latest printing technologies.

12 Examples
Dot matrix, Daisy wheel

printers, Drum Printers and Chain Printers etc.

Laser printers, Inkjet

printers and Thermal Printers etc.

Comparison Chart Between Impact & Non-Impact Printers



Plotters: Plotters are the output devices. 

They can print the data or images on a large 

sized papers. 

Speakers: Speakers are output devices 

that allow you to hear sound from your 

computer. Computer speakers are just like 

stereo speakers. 

Output Devices 

Speakers

Plotters



Central Processing Unit (CPU)

CPU is the brain of any computer system. 

It Coordinates all computer operations and 

Perform arithmetic and logical operations on data. 

The CPU consists of arithmetic and logic units, 

control unit and internal memory (registers). 

❖ The Control unit controls all the 

operations. 

❖ The arithmetic and logic units 

performs addition, subtraction, 

division and multiplication and 

some logical operations.



The electronic storage are of a computer is known as Memory.

Memory is useful to hold / store data and the instructions. 

Computers memory is of two types: 

Primary Memory ( or )Main Memory

Secondary Memory 

Main memory stores the programs and data that are 

currently being used by the computer. 

It holds data and programs temporarily. 

Secondary memory stores the data permanently.

It is also known as auxiliary memory. It is much less expensive. 

Memory Unit



Memory Unit



Primary Memory
Primary Memory is also called as main memory. 

There are different types of memory. 

I. Random Access Memory (RAM) 

II. Read Only Memory (ROM) 

ROM

RAM



Random Access Memory (RAM)
RAM is the main memory for a computer. 

❖ RAM can be used for both reading and writing.

❖ When we switch off a computer, then the data on RAM will be erased. 

❖ It is a volatile memory. 

TYPES OF RAM: 

There are two types of RAM: 

1) Dynamic RAM 2) Static RAM. 

Dynamic RAM (DRAM): Its data has to be refreshed after every few milliseconds. 

DRAM has higher storage capacity. It is cheaper than Static RAM. 

Static RAM (SRAM): Its data need not be refreshed. SRAM has higher speed. It is 

costlier.



Read Only Memory (ROM)
ROM is computer’s internal memory. 

❖ It contains some pre-loaded programs. 

❖ The programs on ROM are helpful for booting. 

There are different types of RAM: 1. PROM 2. EPROM 3. EEPROM 

PROM: It is a Programmable Read Only Memory. PROM allows us to write our own BIOS (Basic 

Input Output System) programs. But these programs can be written only once. 

EPROM: It is Erasable Programmable Read Only Memory. EPROM allows us to write our own BIOS 

programs. These programs can be erased by using an ultraviolet light. 

EEPROM: It is an Electrically Erasable Programmable Read Only Memory. EEPROM allows us to 

write our own BIOS programs. It can be erased by exposing it to an electrical voltage.



Secondary memory is a large, non-

volatile memory. 

It stores the data and instructions 

permanently. 

Some of the commonly used 

secondary storage devices are 

hard disks, magnetic tapes, 

floppy disks and CDROM. 

Secondary Memory/Storage devices



Secondary Memory (Hard Disk)

Hard Disk: Hard disk is a magnetic disk. 

It can store computer data and 

instructions. 
It is a direct-access storage medium. 

A hard disk contains some Tracks and Sectors 

to store the data. 

The arrangement of tracks and sectors on a 

disk is known as its ‘format’. 

Now a days the hard disk in a PC has nearly 

1Tera Byte capacity. 



Secondary Memory

Magnetic Tape:  A magnetic tape is a thin tape with a coating 

of magnetic strip. It is used for recording the data. 

Magnetic tape is a serial access medium. Magnetic tapes are 

generally used for backup. 

Floppy Disk:  A Floppy disk is a thin circular disk used for data 

storage. It is a soft magnetic disk that can be enclosed in a 

protective sheet. It contains tracks and sectors. A floppy has 3.5" in 

size. Some floppy disks would be 5.25" in size. A 3.5" floppy disk can 

hold 1.44 MB of data. 

Compact Disk: Compact disk is a secondary memory device 

that can be written by lasers. It is a random access storage medium. 

It is also known as read/write CD-ROM. It is a popular and cheap 

method for storage.



CACHE Memory

A Cache is a fast responding, small memory 

chip attached between CPU and Main 

memory. 

1. CACHE memories are accessed faster 

than RAM. 

2. It is used to store programs currently 

using by the CPU. 

3. So cache memory makes main memory to 

work faster. 

4. A Cache is available in limited capacity (in 

Kilo Bytes)

CACHE is of 3 Types: 

• Level-1 Cache 

• Level-2 Cache 

• Level-3 Cache



There are different types of registers: 

Accumulator (ACC): It can store the results of arithmetic and logical operations

Instruction Register (IR): It contains the current instruction. 

Program Counter (PC): It contains the address of the next instruction. 

Memory Address Register (MAR): It contains the address of the next location in 

memory. 

Memory Buffer Register (MBR): It temporarily stores the data from memory.

Data Register (DR): It stores the Operands and other data. 

REGISTERS
Registers are the high speed storage areas within a CPU. 

They are also called as CPU’s Working Memory. 

They are useful to the CPU during the execution of the 

instructions. 



Operating systems (OS)
Operating System (OS) is system software.

A program that acts as an intermediary between a user of a computer and the computer 

hardware.

A set of programs that coordinates all activities among computer hardware resources.

Objectives of OS: OS has two main objectives: 

(1) To make the computer system convenient and easy to use. 

(2) To use the computer hardware in an efficient way. 

Examples of OS: 

Microsoft Disk Operating System (MS-DOS), 

Windows XP, Windows 7, Windows 8, Windows 10, 

UNIX, Linux, Mac, Android



1. Process Management 

2. Memory Management 

3. File Management 

4. Device Management 

5. Protection and Security 

6. User interface 

Functions of OS 

Operating 
system

Process 
Management

Memory 
Management

File 
Management

Device 
Management

Protection and 
Security

User Interface



Process management

A process is a unit of work. 

A process can be created, executed and stopped by 

the operating system. A process may have 5 states: 

I. New State 

II. Ready State 

III. Running State 

IV. Waiting State 

V. Terminated State



Memory Management: Every process requires some memory. 

OS performs the memory management functions like: 

I. Allocate memory II. Free memory 

III. Re-allocate memory IV. Maintaining the memory usage details. 

File Management: A file is a collection of related information. OS manages a collection of 

files and directories. It can create and delete files. 

Device Management: OS controls and manages the devices connected to the computer. 

It can communicate with the devices by using device driver software. 

Protection and Security: OS protects the resources of the system. It provides the basic 

protection like user authentication, encryption, backup, etc. 

User interface: OS provides an interface between the user and computer. It allows the 

user to interact with the application and the hardware.

Functions of OS 



Types of Operating Systems

OS are of the following types: 

1. Single User -Single Tasking Operating Systems

2. Single User -Multitasking Operating Systems 

3. Multi User Operating Systems 

4. Multiprocessing Operating Systems 

5. Real time Operating Systems 

6. Embedded Operating Systems



The process of using a computer to create, edit, format and print documents is known as Word Processing. 

To perform word processing, a computer, a special program called a word processor and a printer are required. 

A word processor is an application program that enables the user to create a document, format it, store it, display it 

and print it on a printer. 

• Microsoft Word is the most widely used word processing software. 

• WordPerfect and open Office Writer, Libre Office Writer are some other word processers. 

• Office Web Apps or Google Docs are the Web-based word processors. 

Microsoft Word 2013 is a word-processer that is used to create professional-looking documents such as reports, 

resumes, letters, memos, and newsletters. 

▪ Word processors have a variety of uses in the business, home, and education.

▪ In Business word processing is used for: 

▪ * Letters and letterhead * Memos *Documents.

▪ In the home word processing is used as educational, planning, dealing with assignments. 

▪ Examples: * letter writing * résumé/CV creation.

▪ In education word processing is used the production of assignments, notes, exams, and for practicing its uses! 

Word Processing 



Microsoft Word 2013 is a word-processing program that is used to create professional-looking 

documents such as reports, resumes, letters, memos, and newsletters. 

Features of word processing: Word processors/Microsoft Word has the following features: 

1. Text Manipulation: It allows us to change the appearance of a document by changing words, 

sentences and paragraphs. 

2. Document Formatting: It allows us to format the documents. Formatting improves the 

readability of documents. 

3. Graphics: It allows us to insert Pictures or graphics in a document. 

4. Tabs: It allows us to setup the text on a page in the exact position. 

5. Tables: It allows us to insert tables in a document. The data in a table can be sorted, formatted, 

etc.

6. Mail Merge: Mail merge allows the user to merge a list of names and addresses to a single letter 

that can be sent it to different people. 

7. Spell Checking: It allows the user to check the words for correct spelling. 

Collaborative Editing: It allows two people to simultaneously work on one document as a team. 

Microsoft Word 



You can start Word 2013 from the Start menu. 

→To start Word 2013 from the Start menu: 

1.  Click the Start button → All Programs→ Microsoft Office 2013→Word 2013.

    It shows the Start screen. 

2.  In the right pane, click Blank document. 

    It opens a new, blank document.

Starting Word 



Parts of a MS-WORD window

Menus and Tool bars: The old menu system has been replaced by the Ribbon 

and the Office button in the latest versions of Word.

Title bar: It appears at the top of the window. It displays the title of the 

document. It also shows the buttons to minimize, restore,/maximize, and close 

the window.

Quick Access toolbar: It appears on the left side of the Title bar and contains 

frequently used commands.

Ribbon: It appears below the Title bar. It consists of a set of tabs with related 

commands/Menus.

Navigation pane: It appears on the left side of the window. It enables you to 

navigate long documents, search for specific text.

Document window: It displays the contents of the document.

Cursor: It is a blinking pointer that indicates where the text will be inserted.

Scroll bars: It enable you to scroll through the document.

Status bar: It appears at the bottom of the window. It displays information 

about the document



Creating Documents

An MS-Word document can be created by using the following procedure:

1. Select and Click on Word 2013

2. Select Blank document

• It opens a new document for you to enter your content.

3. You can also create a new document by pressing CTRL + N keys.

Saving Documents

After creating a document, you can save it. 

To save a new document:

1. Click on the File tab

2. Then, click on Save As→ It opens the Save As page window.

Select a location to save the file

4. Type a File name.

5. Click the Save button.

NOTE: 1.Word 2013’s file format is called Word Document. This format has the .docx file extension.

2.You can also save a document in the Word 97-2003 format with the .doc file. This format

works with earlier versions of Word.



Closing Documents

You can close a document after finishing working on it.

To close a document:

1. Click the File tab

2. Then click Close.

3. Or, press Ctrl+W.

Opening Documents

You can locate and open an existing document.

To open a document:

1. Click the File tab

2. Then click Open. Or, press Ctrl+O.

• It opens a list of recently used documents.

3. Locate your document and then click the Open button.

Previewing and Printing Documents

 To preview and print a document:

1. Click the File tab

2. Then click Print. Or, press Ctrl+P.

• It displays print settings

3. Change the print settings as you like.

To print the document, click the Print button.

Editing Documents

Most documents require some editing. You may 

perform basic tasks such as selecting, deleting, 

copying, and moving text, and undoing and redoing 

changes.



Selecting Text

To select text:

1. To select a word, double-click anywhere in the word.

2. To select a sentence, hold down the Ctrl key and click anywhere in the sentence.

3. To select a paragraph, triple-click anywhere in the paragraph

4. To select the entire document press Ctrl+A.

Deleting Text

To delete text:  Select the text that you want to delete, and then press the Delete key.

Moving and Copying Text

You can copy or move the text into a location.

To move or copy text:

1. Select the text that you want to move or copy.

2. Select Home tab and do one of the following:

• To move text, click the Cut button. Or, press Ctrl+X.

• To copy text, click the Copy button. Or, press Ctrl+C.

3. Place the cursor in the required position.

4. Then, Click the Paste button. Or, press Ctrl+V.

Undoing and Redoing Changes

Whenever you make a mistake, you can easily reverse it with the Undo command. 

The Redo command allows you to restore the undone actions.

To undo an action: Click the Undo button. Or, press Ctrl+Z.

To redo an action: Click the Redo button. Or, press Ctrl+Y



Formatting Documents
Formatting is a feature that enhances the appearance of a 

document. Text formatting includes font, font size, font 

color, and etc. 
Different formatting features in MS-Word Word 2013 

has a number of features to format a document. The 

following are some formatting features:

Changing the Font and Font Size and color

A font defines the style of text lettering. The default font in 

Word 2013 documents is Calibri and the default

font size is 11 points.

To change the font:

1. Select the text that you want to format.

2. Click the Font arrow and select the desired font from the list.

To change the font size:

1. Select the text that you want to format.

2. Click the Font Size arrow and select a font size from the list.

To change the font color:

1. Select the text that you want to format.

2. Click the Font Color arrow and select a color.



Paragraph formatting is the layout of a paragraph on the page. You can change a paragraph alignment, 

line spacing, and the space before and after it. 

Formatting Paragraphs

Changing Paragraph Alignment Paragraph alignment refers to the position of a paragraph between the 

left and right margins

To change the alignment of a paragraph: 

1. Select the paragraph that you want to align. 

2. On the Home tab, in the Paragraph group, click the desired alignment button. 



Headers and Footers

Headers and footers are the areas in the top and bottom margins of each page.

• You can insert text or graphics in headers and footers.

• For example, you can add the document title, page numbers, the author’s name, or a logo.

• A header and footer appears on every page.

To insert a header or footer:

1. Click Insert tab

2. Then select the Header & Footer group and click on the Header or Footer button.

Then it opens the header and footer area in the document.

3. Type the required text in the header area.

4. Type the required text in the footer area.

5. Apply the required Formatting features to the header and footer.

6. After finishing, Click on Close header and footer.

Inserting Page Numbers:

Page numbers are the most common type of header or footer.

To insert page numbers:

1. Click Insert tab

2. Then select the Header & Footer group and click on the Header or Footer button.

• Then it opens the header and footer area in the document. 

3. Select Insert Page Number arrow. 

4. Click on the required style. • It will insert the page numbers at the specified position. 

5. After finishing, Click on Close header and footer



Working with Tables
 Tables are commonly used to organize and present data. A table is made up of 

horizontal rows and vertical columns. Inserting Tables Word 2013 makes it quick and 

easy to insert a tab.
Inserting Tables

 Word 2013 makes it quick and easy to insert a table into a document. 

To insert a table: 

1. Click in the document where you want to insert the table. 

2. Select the Insert tab 

3. Select the Tables group and click the Table button

4. Select the desired numbers of rows and columns. 

5. It will insert the table. 

Working with Images
Images can add visual interest to documents. Word 2013 allows you to insert 

images of .gif, .jpg, .png, .bmp, etc. into a document.

To insert an image:

1. Click in the document where you want to insert the image.

2. On the Insert tab, click on the Pictures button

3. It will display an Insert Picture dialog box,

4. Locate and select the desired image and then click the Insert button.



Mail Merge
The mail merge is a process that combines a document with a data source to produce 

personalized documents.

Document contains the text and graphics. Data source contains the addresses of the recipients.

The mail merge process in Word 2013 has the following steps:

 Select the document type and main document.

 Connect the main document to a data source and define the recipients list.

 Add merge fields to the main document.

 Preview the results and complete the merge.

To perform mail merge:

1. Create a new blank document and type your letter.

2. Select Mailings tab and click on Start Mail Merge button.

3. Then click Step-by-Step Mail Merge Wizard.

4. It displays the Mail Merge pane. It has the following 6 steps:



Step 1 of 6: Select document type and select the Letters option.

Step 2 of 6: Select starting document and select the Use the current document option.

Step 3 of 6: Select recipients, select Type a new list option and then click the Create link.

• Type the information of the recipients and save it.

• Click the Next link.

Step 4 of 6: 

click in the document and insert a merge field.

Step 5 of 6: 

Click Preview your letters, click the Next button.

Step 6 of 6: 

Select Merge and click on Print.

The following figure shows mail merge process:

Mail Merge



Definition: A macro is a series of actions.

You can use it to automate a repeated task. So that 

you can run the macro when you have to perform 

that task. It saves time for us.

Creating/Recording a Macro:

The following are the steps to record a macro:

1. Click View > Macros > Record Macro.

2. Type a name for the macro.

3. To assign your macro to a button, click Button.

4. Select new macro and click Add.

5. Click Modify.

6. Choose a button image, type the name you want, 

and click OK twice.

7. Now record the steps.

8. To stop recording, click View > Macros > Stop 

Recording.

• The button for your macro appears on the Quick 

Access Toolbar.

Run a macro

You can run a macro by:

• Clicking the button on the Quick Access 

Toolbar

• Pressing the keyboard shortcut.

• Run the macro from the Macros list.

Steps to run a macro:

1. Click View > Macros > View Macros.

2. Select your Macro name from the list.

3. Click Run.

Disadvantages of Macros:

Some macros can give security problems. 

Sometimes hackers can introduce a 

destructive macro in a file that can spread 

a virus on your computer.

Macro


